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1 Product basics

● Product comparison

● Product features

● Product walkaround
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Product comparison
HP LaserJet P2050 Series models

HP LaserJet P2055 printer

CE456A

HP LaserJet P2055d printer

CE457A

HP LaserJet P2055dn printer

CE459A

HP LaserJet P2055x printer

CE460A

● Prints up to 35 pages per
minute (ppm) on Letter size
paper and 33 ppm on A4
size paper

● Contains 64 megabytes
(MB) of random access
memory (RAM) and is
expandable to 320 MB.

● HP print cartridge, rated for
up to 2,300 pages

● Tray 1 holds up to 50 sheets

● Tray 2 holds up to 250
sheets

● 125-sheet face-down output
bin

● Straight-through output
path

● 2-line control-panel display

● Hi-speed USB 2.0 port

● One open dual inline
memory module (DIMM)
slot

Has the same features as the
HP LaserJet P2055 model
printer, plus the following:

● Two-sided printing
(duplexing)

Has the same features as the
HP LaserJet P2055d model
printer, plus the following:

● HP Jetdirect Standard
Gigabit Ethernet embedded
print server

● Contains 128 MB RAM and
is expandable to 384 MB.

Has the same features as the
HP LaserJet P2055dn model
printer, plus the following:

● Additional 500-sheet tray
(Tray 3)
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Product features
Feature Description

Performance ● 600 MHz processor

User interface ● 2-line display

● HP ToolboxFX software (a Web-based status and problem-solving tool)

● Windows® and Macintosh printer drivers

● Embedded Web server to access support and order supplies (for network-connected models
only)

Printer drivers ● HP PCL 5 Universal Print Driver for Windows (HP UPD PCL 5) (available for download from
the Web)

● HP PCL 6

● HP postscript emulation Universal Print Driver for Windows (HP UPD PS) (available for
download from the Web)

● XPS (XML Paper Specification) Driver (available for download from the Web)

Resolution ● FastRes 1200—produces 1200-dots-per-inch (dpi) print quality for fast, high-quality printing of
business text and graphics

● ProRes 1200—produces 1200-dpi printing for the best quality in line art and graphic images

● 600 dpi—provides the fastest printing

Fonts ● 45 internal scalable fonts available for PCL and 35 for HP UPD postscript emulation

● 80 device-matching screen fonts in TrueType format available with the software solution

Accessories ● HP 500-sheet input tray

● HP Jetdirect external print server

Connectivity ● Hi-Speed USB 2.0 connection

● RJ.45 network connection (network models only)

Supplies ● The supplies status page contains information about toner level, page count, and approximate
pages remaining.

● The product checks for an authentic HP print cartridge at installation.

● Integration with HP Sure Supply Web site for easy replacement-cartridge reordering
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Feature Description

Supported operating systems ● Microsoft® Windows® 2000, Windows® Server 2003, Windows® XP, and Windows Vista™

● Macintosh OS X V10.3, V10.4, V10.5, and later

● Novell NetWare

● Unix®

● Linux

● Citrix

Accessibility ● The online user guide is compatible with text screen-readers.

● The print cartridge can be installed and removed by using one hand.

● All doors and covers can be opened by using one hand.

● Paper can be loaded in Tray 1 by using one hand.
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Product walkaround
Front view

6

1

8

7

3

5

2

4

1 Tray 1 (pull to open)

2 Top output bin

3 Control panel

4 Print-cartridge-door release button

5 On/off switch

6 Optional Tray 3 (included with the HP LaserJet P2055x printer)

7 Tray 2

8 Print-cartridge door
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Rear view

6

1 2
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3
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5

1 Jam-release door (pull the green handle to open)

2 Straight-through paper path (pull to open)

3 DIMM cover (provides access to the DIMM slot)

4 Interface ports

5 Rear duplex jam-release door (duplex models only)

6 Power connection

7 Slot for a cable-type security lock
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Interface ports

1

2

1 Hi-speed USB 2.0 connection, for connecting directly to a computer

2 RJ.45 network connection (network models only)

Model and serial-number label location
The label that contains the model and serial numbers is on the outside of the rear output (straight-through
paper path).
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2 Control panel

● Control-panel layout

● Use the control-panel menus

● Reports menu

● System setup menu

● Service menu

● Network config. menu
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Control-panel layout
Use the control panel to obtain product and job status information and to configure the product.

OK

1

7

6
5
4
3

2

8
Number Button or light Function

1 Control-panel display Shows status information, menus, and error messages

2  Up arrow Navigates to the next submenu or the next value in a menu selection list, moves
the cursor forward a single position, or increases the value of numeric items

3 OK button ● Saves the selected value for an item

● Performs the action that is associated with the item that is highlighted on
the control-panel display

● Clears an error condition when the condition is clearable

4  Down arrow Navigates to the next item in the list, or decreases the value of numeric items

5  Back button Backs up one level in the menu tree or backs up one numeric entry

6 Ready light ● On: The product is online and ready to accept data to print.

● Off: The product cannot accept data because it is offline (paused) or has
experienced an error.

● Blinking: The product is processing a job.

7  Cancel button Cancels the current print job

8 Error light ● Off: The product is functioning without error.

● Blinking: Action is required. See the control-panel display.

10 Chapter 2   Control panel ENWW



Use the control-panel menus
To gain access to the control-panel menus, complete the steps below.

Use the menus
1. Press OK.

2. Press the down arrow  or the up arrow  to navigate the listings.

3. Press OK to select the appropriate option.

4. Press the back button  to return to the previous level.

The following are the main menus.

Main menus Reports

System setup

Service

Network config.
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Reports menu
Use the Reports menu to print reports that provide information about the product.

Menu item Description

Demo page Prints a page that demonstrates print quality.

Menu structure Prints a map of the control-panel-menu layout. The active settings for each menu
are listed.

Config report Prints a list of all the product settings. Includes network information when the product
is connected to a network.

Supplies status Prints the status for the print cartridge, including the following information: 

● Estimated pages remaining

● Part number

● Number of pages printed

Network report Prints a list of all product network settings

Usage page Prints a page that lists PCL 5 pages, PCL 6 pages, PS pages, pages that were
jammed or mispicked in the product; and reports the page count

PCL font list Prints a list of all the PCL 5 fonts that are installed

PS font list Prints a list of all the PostScript (PS) fonts that are installed

PCL 6 font list Prints a list of all the PCL 6 fonts that are installed

Service page Prints the service report
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System setup menu
Use this menu to establish basic product settings. The System setup menu has several sub-menus.
Each is described in the following table.

Menu item Sub-menu item Sub-menu item Description

Language   Select the language for the control-panel
display messages and the product reports.

Quiet mode  On

Off

Enable or disable quiet mode. When quiet
mode is turned on, the product prints at a
slower speed.

The default setting is Off.

Paper setup Def. paper size A list of available paper sizes
appears.

Select the size for printing internal reports or
any print job that does not specify a size.

 Def. paper type A list of available paper types
appears.

Select the media type for printing internal
reports or any print job that does not specify
a type.

 Tray n

NOTE: n = 1, 2, or 3

Paper type

Paper size

Select the default size and type for the tray
from the list of available sizes and types.

 Paper out action Wait forever

Override

Cancel

Select how the product should react when a
print job requires a size or type that is not
available or when a specified tray is empty.

Select Wait forever to make the product wait
until you load the correct media and press
OK. This is the default setting.

Select Override to print on a different size or
type after a specified delay.

Select Cancel to automatically cancel the
print job after a specified delay.

If you select either Override or Cancel, the
control panel prompts you to specify the
number of seconds to delay. Press the up
arrow  to increase the time, up to
3600 seconds. Press the down arrow  to
decrease the time.

Print quality Cartridge low (1-20) The percentage threshold determines when
the product begins reporting low toner.

Print density (1–5)  Select how much toner to apply to thicken
edges and lines.

The default setting is 3.
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Menu item Sub-menu item Sub-menu item Description

Courier font Regular

Dark

 Select a version of the Courier font.

The default is Regular.

Display contrast Medium

Darker

Darkest

Lightest

Lighter

 Adjust the contrast of the LCD.
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Service menu
Use this menu to restore default settings, clean the product, and activate special modes that affect print
output.

Menu item Description

Cleaning mode Use this option to clean the product if you see toner specks or other marks on the
printed output. The cleaning process removes dust and excess toner from the paper
path.

When you select this item, the product prompts you to load plain paper in Tray 1 and
then press OK to start the cleaning process. Wait until the process is complete.
Discard the page that prints.

USB speed Sets the USB speed to High or Full. For the product to actually operate at high
speed, it must have high speed enabled and be connected to an EHCI host controller
that is also operating at high speed. This menu item also does not reflect the current
operating speed of the product.

The default setting is High.

Less paper curl If printed pages are consistently curled, use this option to set the product to a mode
that reduces curl.

The default setting is Off.

Archive print If you are printing pages that will be stored for a long time, use this option to set the
product to a mode that reduces toner smearing and dusting.

The default setting is Off.

Restore defaults Resets all customized settings to the factory default values.
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Network config. menu
Use this menu to establish network configuration settings.

Menu item Description

CFG TCP/IP Access the TCP/IP menu and set TCP/IP protocol parameters.

● BOOTP=YES* Enable IPv4 configuration by a BOOTP Server.

● DHCP=YES* Enable IPv4 configuration by a DHCP Server.

If DHCP=YES* and the print server has a DHCP lease, you can configure the following DHCP
settings:

● RELEASE: Select whether to release (YES) or save (NO) the current lease.

● RENEW: Select whether to renew (YES or NO) the lease.

AUTO IP=YES* Automatically assign a link-local IPv4 address in the form 169.254.x.x.

If you specify BOOTP=NO*, DHCP=NO* and AUTO IP=NO*, you can manually set the following
TCP/IPv4 parameters from the control panel:

● Each byte of the IPv4 address (IP)

● Subnet Mask (SM)

● Syslog Server (LG)

● Default Gateway (GW)

● Idle Timeout period (default is 270 seconds, 0 disables the timeout)

CFG DNS 1: IPv4 address of a primary DNS server (one byte at a time).

CFG DNS 2: IPv4 address of a secondary DNS server (one byte at a time).

IPV6 = YES*: Enable IPv6 operation. Select NO to disable IPv6 operation.

POLICY=RTR_AV/RTR_UN/ALWAYS: Set one of the following IPv6 addressing policies:

● RTR_AV: (default) Stateful auto-configuration method is determined by a router. The router
specifies whether the print server obtains its address, configuration information, or both from
a DHCPv6 server.

● RTR_UN: Attempt to obtain stateful configuration from a DHCPv6 server (when a router is
not available).

● ALWAYS: Always attempt to obtain stateful configuration from a DHCPv6 server (whether
or not a router is available).

MANUAL= KEEP/DISABLE: Set the behavior of a manually configured IPv6 address detected on
the print server.

● KEEP (default): Maintain the address in an active state.

● DISABLE: Maintain the address but in an inactive state.

Print an HP Jetdirect configuration page to verify your settings. (The print server can overwrite
selected parameters with values that ensure proper operation.)
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Menu item Description

WEB Embedded Web server accepts communications using HTTPS (Secure HTTP) only, or both HTTP
and HTTPS.

● HTTPS: Accept only HTTPS (print server appears as a secure site).

● HTTP/HTTPS: Accept either HTTP or HTTPS.

SECURITY Reset current security settings to factory defaults.

● KEEP (default): Retain current security settings.

● RESET: Reset security settings to factory defaults.

FIREWALL Disable Firewall.

● KEEP (default): Retain Firewall operation as configured.

● DISABLE: Disable Firewall operation.

PRINT Print a configuration page for the selected item.

SECURITY: Print the current security settings.

CFG LINK Manually configure the HP Jetdirect print server's network link.

Set the link speed and communication mode. These must match the network. The available
settings depend on the print server model.

CAUTION: Changing the link setting can cause the loss of network communication with the print
server.

● AUTO (default): Use auto-negotiation to set the highest link speed and communication mode
allowed. If auto-negotiation fails, either 100TX HALF or 10TX HALF is set depending on the
detected link speed of the hub/switch port. (A 1000T half-duplex selection is not supported.)

● 10T HALF: 10 Mbps, half-duplex operation.

● 10T FULL: 10 Mbps, Full-duplex operation.

● 100TX HALF: 100 Mbps, half-duplex operation.

● 100TX FULL: 100 Mbps, full-duplex operation.

● 100TX AUTO: Limits auto-negotiation to a maximum link speed of 100 Mbps.

● 1000TX FULL: 1000 Mbps, full-duplex operation.
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3 Software for Windows

● Supported operating systems for Windows

● Supported printer drivers for Windows

● HP Universal Print Driver (UPD)

● Priority for print settings

● Change printer-driver settings for Windows

● Software installation types for Windows

● Remove software for Windows

● Supported utilities for Windows

● Supported network utilities for Windows

● Software for other operating systems
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Supported operating systems for Windows
The product supports the following Windows operating systems:

● Windows XP (32-bit and 64-bit)

● Windows Server 2003 (32-bit and 64-bit)

● Windows 2000 (driver only)

● Windows Vista (32-bit and 64-bit)

Supported printer drivers for Windows
● HP PCL 5 Universal Print Driver (HP UPD PCL 5) (available for download from the Web)

● HP PCL 6 (on the product CD)

● HP postscript emulation Universal Print Driver (HP UPD PS) (available for download from the Web)

● XPS (XML Paper Specification) driver (available for download from the Web)

The printer drivers include online Help that has instructions for common printing tasks and also describes
the buttons, checkboxes, and drop-down lists that are in the printer driver.

NOTE: For more information about the UPD, see www.hp.com/go/upd.
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HP Universal Print Driver (UPD)
The HP Universal Print Driver (UPD) for Windows is a single driver that gives you instant access to
virtually any HP LaserJet product, from any location, without downloading separate drivers. It is built on
proven HP print driver technology and has been tested thoroughly and used with many software
programs. It is a powerful solution that performs consistently over time.

The HP UPD communicates directly with each HP product, gathers configuration information, and then
customizes the user interface to show the product’s unique, available features. It automatically enables
features that are available for the product, such as two-sided printing and stapling, so you do not need
to enable them manually.

For more information, go to www.hp.com/go/upd.

UPD installation modes

Traditional mode ● Use this mode if you are installing the driver from a CD for a single computer.

● When installed with this mode, UPD operates like traditional printer drivers.

● If you use this mode, you must install UPD separately for each computer.

Dynamic mode ● Use this mode if you are installing the driver for a mobile computer, so you can
discover and print to HP products in any location.

● Use this mode if you are installing UPD for a workgroup.

● To use this mode, download UPD from the Internet. See www.hp.com/go/
upd.

ENWW HP Universal Print Driver (UPD) 21

http://www.hp.com/go/upd
http://www.hp.com/go/upd
http://www.hp.com/go/upd


Priority for print settings
Changes to print settings are prioritized depending on where the changes are made:

NOTE: The names of commands and dialog boxes might vary depending on your software program.

● Page Setup dialog box: Click Page Setup or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed here override settings changed
anywhere else.

● Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed in the Print dialog box have a lower
priority and do not override changes made in the Page Setup dialog box.

● Printer Properties dialog box (printer driver): Click Properties in the Print dialog box to open
the printer driver. Settings changed in the Printer Properties dialog box do not override settings
anywhere else in the printing software.

● Default printer driver settings: The default printer driver settings determine the settings used in
all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties dialog
boxes.

● Printer control panel settings: Settings changed at the printer control panel have a lower priority
than changes made anywhere else.

22 Chapter 3   Software for Windows ENWW



Change printer-driver settings for Windows
Change the settings for all print jobs
until the software program is closed

Change the default settings for all
print jobs

Change the product configuration
settings

1. On the File menu in the software
program, click Print.

2. Select the driver, and then click
Properties or Preferences.

The steps can vary; this procedure is
most common.

1. Windows XP and Windows
Server 2003 (using the default
Start menu view): Click Start, and
then click Printers and Faxes.

-or-

Windows 2000, Windows XP, and
Windows Server 2003 (using the
Classic Start menu view): Click
Start, click Settings, and then click
Printers.

-or-

Windows Vista: Click Start, click
Control Panel, and then in the
category for Hardware and
Sound click Printer.

2. Right-click the driver icon, and then
select Printing Preferences.

1. Windows XP and Windows
Server 2003 (using the default
Start menu view): Click Start, and
then click Printers and Faxes.

-or-

Windows 2000, Windows XP, and
Windows Server 2003 (using the
Classic Start menu view): Click
Start, click Settings, and then click
Printers.

-or-

Windows Vista: Click Start, click
Control Panel, and then in the
category for Hardware and
Sound click Printer.

2. Right-click the driver icon, and then
select Properties.

3. Click the Device Settings tab.
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Software installation types for Windows
You can choose from the following types of software installations:

● Basic Installation (Recommended). Installs the minimum set of drivers and software. This
installation type is recommended for network installations.

● Full Installation. Installs the full set of drivers and software, including status, alerting, and
troubleshooting tools. This installation type is recommended for direct-connect installations.

● Custom Installation. Use this option to select which drivers to install and whether to install the
internal fonts. This installation type is recommended for advanced users and system
administrators.

Remove software for Windows
1. Click Start, and then click All Programs.

2. Click HP, and then click the product name.

3. Click the option to uninstall the product, and then follow the onscreen instructions to remove the
software.
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Supported utilities for Windows
HP ToolboxFX

HP ToolboxFX is a software program that you can use for the following tasks:

● Checking the product status

● Checking the supplies status and ordering supplies online

● Setting up alerts

● Setting up e-mail notification for certain product and supplies events

● Viewing and changing product settings

● Viewing product documentation

● Gaining access to troubleshooting and maintenance tools

You can view HP ToolboxFX when the product is directly connected to your computer or is connected
to a network. To use HP ToolboxFX, perform a recommended software installation.
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Supported network utilities for Windows
HP Web Jetadmin

HP Web Jetadmin is a browser-based management tool for HP Jetdirect-connected printers within your
intranet, and it should be installed only on the network administrator’s computer.

To download a current version of HP Web Jetadmin and for the latest list of supported host systems,
visit www.hp.com/go/webjetadmin.

When installed on a host server, a Windows client can gain access to HP Web Jetadmin by using a
supported Web browser (such as Microsoft® Internet Explorer 4.x or Netscape Navigator 4.x or later)
by navigating to the HP Web Jetadmin host.

Embedded Web server
The device is equipped with an embedded Web server, which provides access to information about
device and network activities. This information appears in a Web browser, such as Microsoft Internet
Explorer, Netscape Navigator, Apple Safari, or Firefox.

The embedded Web server resides on the device. It is not loaded on a network server.

The embedded Web server provides an interface to the device that anyone who has a network-
connected computer and a standard Web browser can use. No special software is installed or
configured, but you must have a supported Web browser on your computer. To gain access to the
embedded Web server, type the IP address for the device in the address line of the browser. (To find
the IP address, print a configuration page. For more information about printing a configuration page,
see Print the information pages on page 70.)

For a complete explanation of the features and functionality of the embedded Web server, see
Embedded Web server on page 77.

Software for other operating systems
OS Software

UNIX To download the HP UNIX modelscripts, follow these steps.

1. Go to www.hp.com, and click Software & Driver Download.

2. Type the name of the product in the product name box.

3. In the list of operating systems, click UNIX.

4. Download the appropriate file or files.

Linux For information, go to www.hp.com/go/linuxprinting.
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4 Use the product with Macintosh

● Software for Macintosh

● Use features in the Macintosh printer driver
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Software for Macintosh
Supported operating systems for Macintosh

The product supports the following Macintosh operating systems:

● Mac OS X V10.3, V10.4, V10.5, and later

NOTE: For Mac OS X V10.4 and later, PPC and Intel® Core™ Processor Macs are supported.

Supported printer drivers for Macintosh
The HP installer provides PostScript® Printer Description (PPD) files, Printer Dialog Extensions (PDEs),
and the HP Printer Utility for use with Macintosh computers.

The PPDs, in combination with the Apple PostScript printer drivers, provide access to device features.
Use the Apple PostScript printer driver that comes with the computer.

Remove software from Macintosh operating systems
To remove the software from a Macintosh computer, drag the PPD files to the trash can.

Priority for print settings for Macintosh
Changes to print settings are prioritized depending on where the changes are made:

NOTE: The names of commands and dialog boxes might vary depending on your software program.

● Page Setup dialog box: Click Page Setup or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed here might override settings changed
anywhere else.

● Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed in the Print dialog box have a lower
priority and do not override changes made in the Page Setup dialog box.

● Default printer driver settings: The default printer driver settings determine the settings used in
all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties dialog
boxes.

● Printer control panel settings: Settings changed at the printer control panel have a lower priority
than changes made anywhere else.
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Change printer-driver settings for Macintosh

Change the settings for all print jobs
until the software program is closed

Change the default settings for all
print jobs

Change the product configuration
settings

1. On the File menu, click Print.

2. Change the settings that you want
on the various menus.

1. On the File menu, click Print.

2. Change the settings that you want
on the various menus.

3. On the Presets menu, click Save
as and type a name for the preset.

These settings are saved in the
Presets menu. To use the new settings,
you must select the saved preset option
every time you open a program and print.

Mac OS X V10.3 or Mac OS X V10.4

1. From the Apple menu, click System
Preferences and then Print &
Fax.

2. Click Printer Setup.

3. Click the Installable Options
menu.

Mac OS X V10.5

1. From the Apple menu, click System
Preferences and then Print &
Fax.

2. Click Options & Supplies.

3. Click the Driver menu.

4. Select the driver from the list, and
configure the installed options.

Supported utilities for Macintosh

Embedded Web server
The device is equipped with an embedded Web server, which provides access to information about
device and network activities. This information appears in a Web browser, such as Microsoft Internet
Explorer, Netscape Navigator, Apple Safari, or Firefox.

The embedded Web server resides on the device. It is not loaded on a network server.

The embedded Web server provides an interface to the device that anyone who has a network-
connected computer and a standard Web browser can use. No special software is installed or
configured, but you must have a supported Web browser on your computer. To gain access to the
embedded Web server, type the IP address for the device in the address line of the browser. (To find
the IP address, print a configuration page. For more information about printing a configuration page,
see Print the information pages on page 70.)

For a complete explanation of the features and functionality of the embedded Web server, see
Embedded Web server on page 77.
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Use features in the Macintosh printer driver
Print

Create and use printing presets in Macintosh
Use printing presets to save the current printer driver settings for reuse.

Create a printing preset

1. On the File menu, click Print.

2. Select the driver.

3. Select the print settings.

4. In the Presets box, click Save As..., and type a name for the preset.

5. Click OK.

Use printing presets

1. On the File menu, click Print.

2. Select the driver.

3. In the Presets box, select the printing preset that you want to use.

NOTE: To use printer-driver default settings, select Standard.

Resize documents or print on a custom paper size
You can scale a document to fit on a different size of paper.

1. On the File menu, click Print.

2. Open the Paper Handling menu.

3. In the area for Destination Paper Size, select Scale to fit paper size, and then select the size
from the drop-down list.

4. If you want to use only paper that is smaller than the document, select Scale down only.

Print a cover page
You can print a separate cover page for your document that includes a message (such as “Confidential”).

1. On the File menu, click Print.

2. Select the driver.

3. Open the Cover Page menu, and then select whether to print the cover page Before Document
or After Document.

4. In the Cover Page Type menu, select the message that you want to print on the cover page.

NOTE: To print a blank cover page, select Standard as the Cover Page Type.
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Use watermarks
A watermark is a notice, such as “Confidential,” that is printed in the background of each page of a
document.

1. On the File menu, click Print.

2. Open the Watermarks menu.

3. Next to Mode, select the type of watermark to use. Select Watermark to print a semi-transparent
message. Select Overlay to print a message that is not transparent.

4. Next to Pages, select whether to print the watermark on all pages or on the first page only.

5. Next to Text, select one of the standard messages, or select Custom and type a new message in
the box.

6. Select options for the remaining settings.

Print multiple pages on one sheet of paper in Macintosh
You can print more than one page on a single sheet of paper. This feature provides a cost-effective way
to print draft pages.

1. On the File menu, click Print.

2. Select the driver.

3. Open the Layout menu.

4. Next to Pages per Sheet, select the number of pages that you want to print on each sheet (1, 2,
4, 6, 9, or 16).

5. Next to Layout Direction, select the order and placement of the pages on the sheet.

6. Next to Borders, select the type of border to print around each page on the sheet.
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Print on both sides of the page

Use automatic two-sided printing (duplex models only)

1. Set the product for the correct width of paper that you are using. At the back of the product, lift the
duplex jam-release door, and locate the blue paper-width selection lever.

● Letter and Legal-size paper: Push the lever in.

● A4-size paper: Pull the lever out.

2. Insert enough paper into one of the trays to accommodate the print job. If you are loading special
paper such as letterhead, load it in one of the following ways:

● For Tray 1, load the letterhead paper face-up with the top edge feeding into the product first.

● For all other trays, load the letterhead paper face-down with the top edge at the front of the
tray.

3. On the File menu, click Print.

4. Open the Layout menu.

5. Next to Two-Sided, select either Long-Edge Binding or Short-Edge Binding.

6. Click Print.

Print on both sides manually

1. Insert enough paper into one of the trays to accommodate the print job. If you are loading special
paper such as letterhead, load it in one of the following ways:

● For Tray 1, load the letterhead paper face-up with the top edge feeding into the product first.

● For all other trays, load the letterhead paper face-down with the top edge at the front of the
tray.

2. On the File menu, click Print.

3. On the Finishing menu, select Manually Print on 2nd Side.

4. Click Print. Follow the instructions in the pop-up window that appears on the computer screen
before placing the output stack in Tray 1 for printing the second half.

5. Go to the product, and remove any blank paper that is in Tray 1.

6. Insert the printed stack face-up into Tray 1 with the top edge feeding into the product first. You
must print the second side from Tray 1.

7. If prompted, press the appropriate control-panel button to continue.
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Use the Services menu
If the product is connected to a network, use the Services menu to obtain product and supply-status
information.

1. On the File menu, click Print.

2. Open the Services menu.

3. To open the embedded Web server and perform a maintenance task, do the following:

a. Select Device Maintenance.

b. Select a task from the drop-down list.

c. Click Launch.

4. To go to various support Web sites for this device, do the following:

a. Select Services on the Web.

b. Select Internet Services, and select an option from the drop-down list.

c. Click Go!.
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5 Connectivity

● USB configuration

● Network configuration
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USB configuration
The product has a Hi-Speed USB 2.0 port. The USB cable can be a maximum of 2 meters (6 feet) long.

Connect the USB cable
Plug the USB cable into the product. Plug the other end of the USB cable into the computer.

1 Type B USB port

2 Type B USB connector
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Network configuration
You might need to configure certain network parameters on the product. You can configure these
parameters from the control panel, the embedded Web server, or for most networks, from the HP Web
Jetadmin software.

Supported network protocols
The product supports the TCP/IP network protocol. It is the most widely used and accepted networking
protocol. Many networking services utilize this protocol. This product also supports IPv4 and IPv6. The
following tables list the networking services/protocols that are supported on the product.

Table 5-1  Printing

Service name Description

port9100 (Direct Mode) The default TCP/IP printing port on the HP Jetdirect print
server, accessed by software such as HP Standard Port

Line printer daemon (LPD) LPD provides line printer spooling services for TCP/IP
systems. Use LPD services on the HP Jetdirect print server.

WS Print Use the Microsoft Web Services for Devices (WSD) Print
services supported on the HP Jetdirect print server.

Table 5-2  Network product discovery

Service name Description

SLP (Service Location Protocol) Device Discovery Protocol, used to help find and configure
network devices. Used primarily by Microsoft-based software
programs.

mDNS (multicast Domain Name Service - also known as
“Rendezvous” or “Bonjour”)

Device Discovery Protocol, used to help find and configure
network devices. Used primarily by Apple Macintosh-based
software programs.

WS Discovery Allows Microsoft WS discovery protocols on the print server.

LLMNR (TCP/IP v6) Indicates whether link local multicast name resolution
(LLMNR) requests are responded to over IPv6.

NetBIOS over TCP/IP Provides communication among applications on separate
computers within a local area network. Because the
programming interface runs through TCP/IP (NBT), each
computer in the network has both a NetBIOS name and an IP
address relevant to a host name (even though the two names
might not be the same).

DNS Client DNS domain name that the HP Jetdirect print server resides in
(for example, support.hp.com).

Table 5-3  Messaging and management

Service name Description

HTTP (hypertext transfer protocol) Allows Web browsers to communicate with embedded Web
server.

EWS (embedded Web server) Allows a user to manage the product through a Web browser.
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Service name Description

SNMP (simple network management protocol) Used by network programs for product management. SNMP
V3 and standard MIB-II (Management Information Base)
objects are supported.

Web Jetadmin (WJA) Management application that provides controlled access to
HP Jetdirect and printer features.

EPC HP Easy Printer Care Software 2.0 (EPC 2.0) provides
HP Web Jetadmin-type functions for small and micro
businesses with up to 15 HP LaserJet products. EPC 2.0
delivers effortless laser printer upkeep and protection for your
printing investment, as well as simple, consolidated supplies
replenishment.

Table 5-4  IP addressing

Service name Description

DHCP (dynamic host configuration protocol) For Automatic IP address assignment. DHCP server provides
the product with an IP address. Generally requires no user
intervention for product to obtain IP address from a DHCP
server.

BOOTP (bootstrap protocol) For Automatic IP address assignment. BOOTP server
provides the product with an IP address. Requires
administrator to input the product MAC hardware address on
BOOTP server in order for product to obtain an IP address from
that server.

Auto IP For Automatic IP address assignment. If neither a DHCP
server nor a BOOTP server is present, this service allows the
product to generate a unique IP address.

Manual IP Manually configure the IP address on the print server using the
printer control panel or the embedded Web server.

Telnet Set configuration parameters by using the default IP address
to create a Telnet connection from your system to the HP
Jetdirect print server. Once configured, the print server saves
the configuration when turned off and then turned on.

RARP You can configure the print server to use RARP on UNIX and
Linux systems. Use RARP to answer the print server's RARP
request and supply the print server with the IP address. The
RARP method allows you to only configure the IP address.

ARP/PING You can configure an HP Jetdirect print server with an IP
address using the arp command from a supported system.
The workstation from which the configuration is made must be
located on the same network segment as the HP Jetdirect print
server.

Install the product on a network
In this configuration, the product is connected directly to the network and can be configured to allow all
computers on the network to print directly to the product.

Table 5-3  Messaging and management (continued)
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NOTE: This mode is the recommended network configuration for the product.

1. Before turning on the product, connect the product directly to the network by inserting a network
cable into the product network port.

2. Turn on the product, wait 2 minutes, and then use the control panel to print a configuration page.

NOTE: Make sure that an IP address is listed on the configuration page before proceeding to the
next step. If an IP address is not present, reprint the configuration page.

3. Insert the product CD into the computer. If the software installer does not start, navigate to the
setup.exe file on the CD and double-click the file.

4. Follow the installer instructions.

NOTE: When the installer prompts for a network address, provide the IP address listed on the
configuration page that you printed before starting the installer program, or search for the product
on the network.

5. Allow the installation process to complete.

Configure the network product

View or change network settings
You can use the embedded Web server to view or change IP configuration settings.

1. Print a configuration page, and locate the IP address.

● If you are using IPv4, the IP address contains only digits. It has this format:

xxx.xxx.xxx.xxx

● If you are using IPv6, the IP address is a hexadecimal combination of characters and digits.
It has this format:

xxxx::xxx:xxxx:xxxx:xxxx

2. Type the IP address into the address line of a Web browser to open the embedded Web server.

3. Click the Networking tab to obtain network information. You can change settings as needed.

Set or change the network password
Use the embedded Web server to set a network password or change an existing password.

1. Open the embedded Web server and click the Networking tab.

2. In the left-side pane, click Authorization.

NOTE: If a password has previously been set, you are prompted to type the password. Type the
password, and then click the Apply button.

3. Type the new password in the Password box and in the Confirm Password box.

4. At the bottom of the window, click the Apply button to save the password.
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IP address
The product IP address can be set manually, or it can be configured automatically via DHCP, BootP, or
AutoIP.

Automatic configuration

1. On the control panel, press OK.

2. Use the arrow buttons to select Network config., and then press OK.

3. Use the arrow buttons to select either BOOTP or DHCP, and then press OK.

4. Use the arrow buttons to select Yes, and then press OK.

It may take several minutes before the automatic IP address is ready for use.

5. Use the Back or Cancel button to leave the Network config. menu.

NOTE: Specific automatic IP modes (such as BOOTP, DHCP, or AutoIP) can be changed by using
the embedded Web server or HP ToolboxFX only. If AutoIP is disabled, HP default IP (192.0.0.192) will
automatically be enabled.

Manual configuration

1. On the control panel, press OK.

2. Use the arrow buttons to select Network config., and then press OK.

3. Use the arrow buttons to select CFG TCP/IP, and then press OK.

4. Use the arrow buttons to select BOOTP, make sure the value is No, and then press OK.

5. Use the arrow buttons to select DHCP, make sure the value is No, and then press OK.

6. Use the arrow buttons to select IP BYTE 1, and then press OK.

7. Use the arrow buttons to change the value of IP BYTE 1, and then press OK.

8. Repeat steps 6 and 7 for IP BYTE 2, IP BYTE 3, and IP BYTE 4. Also, repeat steps 6 and 7 for
the Subnet Mask (SM BYTE 1, SM BYTE 2, SM BYTE 3, SM BYTE 4) and Default Gateway (GW
BYTE 1, GW BYTE 2, GW BYTE 3, GW BYTE 4).

9. Use the Back or Cancel button to leave the Network config. menu.

IPv4 and IPv6 settings

The IPv4 and IPv6 protocols can be configured manually. The IPv4 protocol can be set from
HP ToolboxFX or from the product control panel. The IPv6 protocol can be set from the product control
panel or the embedded Web server.
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Link speed setting
NOTE: Incorrect changes to the link speed setting might prevent the product from communicating with
other network devices. For most situations, the product should be left in automatic mode. Changes can
cause the product to power cycle. Changes should be made only while the product is idle.

1. On the control panel, press OK.

2. Use the arrow buttons to select Network config., and then press OK.

3. Use the arrow buttons to select CFG LINK, and then press OK.

4. Use the arrow buttons to select LINK, and then press OK.

5. Use the arrow buttons to select one of the following settings.

● AUTO

● 10T HALF

● 10T FULL

● 100TX HALF

● 100TX FULL

● 100TX AUTO

● 1000TX FULL

NOTE: The setting must match with the network product to which you are connecting (a network
hub, switch, gateway, router, or computer).
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6 Paper and print media

● Understand paper and print media use

● Supported paper and print media sizes

● Custom paper sizes

● Supported paper and print media types

● Tray and bin capacity

● Special paper or print media guidelines

● Load trays

● Configure trays

● Use paper output options
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Understand paper and print media use
This product supports a variety of paper and other print media in accordance with the guidelines in this
user guide. Paper or print media that does not meet these guidelines might cause the following problems:

● Poor print quality

● Increased jams

● Premature wear on the product, requiring repair

For best results, use only HP-brand paper and print media designed for laser printers or multiuse. Do
not use paper or print media made for inkjet printers. Hewlett-Packard Company cannot recommend
the use of other brands of media because HP cannot control their quality.

It is possible for paper to meet all of the guidelines in this user guide and still not produce satisfactory
results. This might be the result of improper handling, unacceptable temperature and/or humidity levels,
or other variables over which Hewlett-Packard has no control.

CAUTION: Using paper or print media that does not meet Hewlett-Packard's specifications might
cause problems for the product, requiring repair. This repair is not covered by the Hewlett-Packard
warranty or service agreements.
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Supported paper and print media sizes
This product supports a number of paper sizes, and it adapts to various media.

NOTE: To obtain best results, select the correct paper size and type in the printer driver before printing.

Table 6-1  Supported paper and print media sizes

Size and dimensions Tray 1 Tray 2 Optional 500-sheet
Tray 3

Duplexer (duplex
models only)

Letter

216 x 279 mm (8.5 x 11 inches)

Legal

216 x 356 mm (8.5 x 14 inches)

A4

210 x 297 mm (8.27 x 11.69 inches)

A5

148 x 210 mm (5.83 x 8.27 inches)

 

A6

105 x 148 mm (4.1 x 5.8 inches)

 

B5 (JIS)

182 x 257 mm (7.17 x 10.12 inches)

 

Executive

184 x 267 mm (7.24 x 10.51 inches)

 

Postcard (JIS)

100 x 148 mm (3.9 x 5.8 inches)

   

Double Postcard (JIS)

148 x 200 mm (5.8 x 7.9 inches)

   

16K

184 x 260 mm (7.2 x 10.2 inches)

   

16K

195 x 270 mm (7.7 x 10.6 inches)

   

16K

197 x 273 mm (7.8 x 10.8 inches)

   

8.5 x 13

216 x 330 mm (8.5 x 13 inches)

Envelope Commercial #10

105 x 241 mm (4.13 x 9.49 inches)
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Size and dimensions Tray 1 Tray 2 Optional 500-sheet
Tray 3

Duplexer (duplex
models only)

Envelope B5 ISO

176 x 250 mm (6.7 x 9.8 inches)

   

Envelope C5 ISO

162 x 229 mm (6.93 x 9.84 inches)

   

Envelope DL ISO

110 x 220 mm (4.33 x 8.66 inches)

   

Envelope Monarch

98 x 191 mm (3.9 x 7.5 inches)

   

Custom

76 x 127 mm to 216 x 356 mm

(3.0 x 5.0 inches to 8.5 x 14 inches)

   

Custom paper sizes
This product supports a variety of custom paper sizes. Supported custom sizes are sizes that are within
the minimum- and maximum-size guidelines for the product but are not listed in the supported paper
sizes table. When using a supported custom size, specify the custom size in the print driver, and load
the paper in a tray that supports custom sizes.

Table 6-1  Supported paper and print media sizes (continued)
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Supported paper and print media types
For a complete list of specific HP-brand paper that this product supports, go to www.hp.com/support/
ljp2050series.

Paper type (control panel) Paper type (printer driver) Tray 1 Tray 2 Optional 500-
sheet Tray 3

Duplexer
(duplex
models only)

PLAIN 75–95 G Plain

LIGHT 60-74 G Light 60-74g

MID-WEIGHT Mid-weight

HEAVY 111–130 G Heavy 111–130g  

EXTRA HEAVY 131–175 G Extra heavy 131–175g    

TRANSPARENCY Monochrome Laser
Transparency

 

LABELS Labels    

LETTERHEAD Letterhead

PREPRINTED Preprinted

PREPUNCHED Prepunched

COLOR Colored

ROUGH Rough  

BOND Bond

RECYCLED Recycled

ENVELOPE Envelope    
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Tray and bin capacity
Tray or bin Paper type Specifications Quantity

Tray 1 Paper Range:

60 g/m2 (16 lb) bond to 200 g/m2

(54 lb) bond

Maximum stack height: 5 mm
(0.3 inch)

Equivalent to 50 sheets of 75 g/
m2 (20 lb) bond

Envelopes Less than 60 g/m2 (16 lb) bond to
90 g/m2 (24 lb) bond

Up to 10 envelopes

Labels Maximum 0.23 mm (0.009 inch)
thick

Maximum stack height: 5 mm
(0.3 inch)

Transparencies Minimum 0.13 mm (0.005 inch)
thick

Maximum stack height: 5 mm
(0.3 inch)

Tray 2 Paper Range:

60 g/m2 (16 lb) bond to 135 g/m2

(36 lb) bond

Equivalent to 250 sheets of 75 g/
m2 (20 lb) bond

Maximum stack height for A6
paper: 15 mm (0.59 inch)

Transparencies Minimum 0.13 mm (0.005 inch)
thick

Maximum stack height: 26 mm
(1.0 inch)

Optional 500-sheet Tray 3 Paper Range:

60 g/m2 (16 lb) bond to 135 g/m2

(36 lb) bond

Equivalent to 500 sheets of 75 g/
m2 (20 lb) bond

Maximum stack height for A6
paper: 40 mm (1.6 inches)

Transparencies Minimum 0.13 mm (0.005 inch)
thick

Maximum stack height: 54 mm
(2.1 inches)

Standard top bin Paper  Up to 125 sheets of 75 g/m2 (20
lb) bond
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Special paper or print media guidelines
This product supports printing on special media. Use the following guidelines to obtain satisfactory
results. When using special paper or print media, be sure to set the type and size in your print driver to
obtain the best print results.

CAUTION: HP LaserJet printers use fusers to bond dry toner particles to the paper in very precise
dots. HP laser paper is designed to withstand this extreme heat. Using inkjet paper not designed for this
technology could damage your printer.

Media type Do Do not

Envelopes ● Store envelopes flat.

● Use envelopes where the seam
extends all the way to the corner of
the envelope.

● Use peel-off adhesive strips that
are approved for use in laser
printers.

● Do not use envelopes that are
wrinkled, nicked, stuck together, or
otherwise damaged.

● Do not use envelopes that have
clasps, snaps, windows, or coated
linings.

● Do not use self-stick adhesives or
other synthetic materials.

Labels ● Use only labels that have no
exposed backing between them.

● Use Labels that lie flat.

● Use only full sheets of labels.

● Do not use labels that have wrinkles
or bubbles, or are damaged.

● Do not print partial sheets of labels.

Transparencies ● Use only transparencies that are
approved for use in laser printers.

● Place transparencies on a flat
surface after removing them from
the product.

● Do not use transparent print media
not approved for laser printers.

Letterhead or preprinted forms ● Use only letterhead or forms
approved for use in laser printers.

● Do not use raised or metallic
letterhead.

Heavy paper ● Use only heavy paper that is
approved for use in laser printers
and meets the weight specifications
for this product.

● Do not use paper that is heavier
than the recommended media
specification for this product unless
it is HP paper that has been
approved for use in this product.

Glossy or coated paper ● Use only glossy or coated paper
that is approved for use in laser
printers.

● Do not use glossy or coated paper
designed for use in inkjet products.
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Load trays
Paper orientation for loading trays

If you are using paper that requires a specific orientation, load it according to the information in the
following table.

Tray Single-sided printing Duplex printing (duplex
models only)

Envelope printing 

Tray 1 Face-up

Top edge leading into the product

Face-up

Top edge leading into the product

Front of envelope face-up

Short edge with postage leading
into the product

All other trays Face-down

Top edge at the front of the tray

Face-down

Top edge at the front of the tray

Use only Tray 1 for printing
envelopes.

50 Chapter 6   Paper and print media ENWW



Tray 1
Tray 1 is accessed from the front of the printer. The printer prints from tray 1 before attempting to print
from other trays.

Media guides ensure that the media is correctly fed into the printer and that the print is not skewed
(crooked on the media). When loading media, adjust the media guides to match the width of the media
that you are using.
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Tray 2 and optional Tray 3
Media guides ensure that the media feeds correctly into the printer and that the print is not skewed.
Tray 2 has side and rear media guides. When loading media, adjust the media guides to match the
length and width of the media that you are using.

NOTE: When you add new media, make sure that you remove all of the media from the input tray and
straighten the stack of new media. This reduces jams by preventing multiple sheets of media from
feeding through the printer at one time.

Load A6-size paper
When loading A6-size paper, adjust the length by sliding forward only the center panel of the rear media
guide.
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Manual feed
You can use manual feed when printing mixed media. For example, you can use manual feed to print
an envelope, then a letter, then an envelope, and so on. Load envelopes in Tray 1 and load letterhead
into Tray 2.

To print using manual feed, open the printer Properties or Printer Setup, and then select Manual Feed
(tray 1) from the Source Tray drop-down list. After you have enabled manual feed, press the OK button
to print.
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Configure trays
1. Press OK.

2. Press the down arrow  to select System setup, and then press OK.

3. Press the down arrow  to select Paper setup, and then press OK.

4. Press the down arrow  to select the desired tray, and then press OK.

5. Press the down arrow  to select Paper type or Paper size, and then press OK.

6. Press the down arrow  to select the size or type.

7. Press OK to save the settings.
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Use paper output options 
The product has two output locations: the top (standard) output bin and the straight-through paper path
(rear output).

Print to the top (standard) output bin
The top output bin collects paper face-down, in the correct order. The top output bin should be used for
most print jobs, including transparencies. To use the top output bin, be sure that the rear output (straight-
through paper path) is closed. To avoid jams, do not open or close the rear output while the product is
printing.
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Print to the straight-through paper path (rear output)
The product always uses the straight-through paper path if it is open. Paper exits face-up, with the last
page on top (reverse order).

Printing from Tray 1 to the rear output provides the straightest path. Opening the straight-through paper
path might improve performance with the following paper types:

● Envelopes

● Labels

● Small custom-size paper

● Postcards

● Paper heavier than 120 g/m2 (32 lb)

To open the straight-through paper path, grasp the handle at the top of the rear door, and pull the door
down.

NOTE: Be sure to open the straight-through paper path, not the jam-release door.
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7 Use product features

● EconoMode

● Quiet mode
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EconoMode
This product has an EconoMode option for printing drafts of documents. Using EconoMode can use
less toner and decrease the cost per page. However, using EconoMode can also reduce print quality.

HP does not recommend full-time use of EconoMode. If EconoMode is used full-time, the toner supply
might outlast the mechanical parts in the print cartridge. If print quality begins to degrade under these
circumstances, you will need to install a new print cartridge, even if there is toner supply remaining in
the cartridge.

Enable or disable EconoMode in any of these ways:

● In the embedded Web server (network models only), open the Settings tab and select the
Configure Device option. Navigate to the Print Quality submenu.

● In the Windows PCL printer driver, open the Paper/Quality tab, and select the EconoMode option.
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Quiet mode
This product has a quiet mode that reduces noise during printing. When quiet mode is turned on, the
product prints at a slower speed.

Follow these steps to enable quiet mode.

1. On the control panel, press OK.

2. Press the down arrow  to select System setup, and then press OK.

3. Press the down arrow  to select Quiet mode, and then press OK.

4. Press the down arrow  to select On, and then press OK.
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8 Print tasks

● Cancel a print job

● Use features in the Windows printer driver
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Cancel a print job
You can stop a print request by using the control panel or by using the software program. For instructions
about how to stop a print request from a computer on a network, see the online Help for the specific
network software.

NOTE: It can take some time for all printing to clear after you have canceled a print job.

Stop the current print job from the control panel
� Press the Cancel button  on the control panel.

Stop the current print job from the software program
When you send the print job, a dialog box appears briefly on the screen, giving you the option to cancel
the print job.

If several requests have been sent to the product through your software, they might be waiting in a print
queue (for example, in Windows Print Manager). See the software documentation for specific
instructions about canceling a print request from the computer.

If a print job is waiting in a print queue or print spooler, delete the print job there.

1. Windows XP and Windows Server 2003 (using the default Start menu view): Click Start, click
Settings, and then click Printers and Faxes.

-or-

Windows 2000, Windows XP, and Windows Server 2003 (using the Classic Start menu
view): Click Start, click Settings, and then click Printers.

-or-

Windows Vista: Click Start, click Control Panel, and then in the category for Hardware and
Sound click Printer.

2. In the list of printers, double-click the name of this product to open the print queue or spooler.

3. Select the print job that you want to cancel, and then press Delete.
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Use features in the Windows printer driver
NOTE: The following information is for the HP PCL 6 printer driver.

Open the printer driver

How do I Steps to perform

Open the printer driver On the File menu in the software program, click Print. Select
the printer, and then click Properties or Preferences.

Get help for any printing option Click the ? symbol in the upper-right corner of the printer driver,
and then click any item in the printer driver. A pop-up message
displays that provides information about the item. Or, click
Help to open the online Help.

Use printing shortcuts
To perform the following tasks, open the printer driver and click the Printing Shortcuts tab.

NOTE: In previous HP printer drivers, this feature was called Quick Sets.

How do I Steps to perform

Use a printing shortcut Select one of the shortcuts, and then click OK to print the job
with the predefined settings.

Create a custom printing shortcut a) Select an existing shortcut as a base. b) Select the print
options for the new shortcut. c) Click Save As, type a name for
the shortcut, and click OK.
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Set paper and quality options
To perform the following tasks, open the printer driver and click the Paper/Quality tab.

How do I Steps to perform

Select a page size Select a size from the Paper size drop-down list.

Select a custom page size a) Click Custom. The Custom Paper Size dialog box opens.
b) Type a name for the custom size, specify the dimensions,
and click OK.

Select a paper source Select a tray from the Paper source drop-down list.

Select a paper type Select a type from the Paper type drop-down list.

Print covers on different paper

Print the first or last page on different paper

a) In the Special pages area, click Covers or Print pages on
different paper, and then click Settings. b) Select an option
to print a blank or preprinted front cover, back cover, or both.
Or, select an option to print the first or last page on different
paper. c) Select options from the Paper source and Paper
type drop-down lists, and then click Add. d) Click OK.

Adjust the resolution of printed images In the Print Quality area, select an option from the drop-down
list. See the printer-driver online Help for information about
each of the available options.

Select draft-quality printing In the Print Quality area, click EconoMode.

Set document effects
To perform the following tasks, open the printer driver and click the Effects tab.

How do I Steps to perform

Scale a page to fit on a selected paper size Click Print document on, and then select a size from the drop-
down list.

Scale a page to be a percent of the actual size Click % of actual size, and then type the percent or adjust the
slider bar.

Print a watermark a) Select a watermark from the Watermarks drop-down list.
b) To print the watermark on the first page only, click First page
only. Otherwise, the watermark is printed on each page.

Add or edit watermarks

NOTE: The printer driver must be stored on your computer
for this to work.

a) In the Watermarks area, click Edit. The Watermark
Details dialog box opens. b) Specify the settings for the
watermark, and then click OK.

64 Chapter 8   Print tasks ENWW



Set document finishing options
To perform the following tasks, open the printer driver and click the Finishing tab.

How do I Steps to perform

Print on both sides (duplex models only) 1. Set the product for the correct width of paper that you are
using. At the back of the product, lift the duplex jam-
release door, and locate the blue paper-width selection
lever.

◦ Letter and Legal-size paper: Push the lever in.

◦ A4-size paper: Pull the lever out.

2. Insert enough paper into one of the trays to accommodate
the print job. If you are loading special paper such as
letterhead, load it in one of the following ways:

◦ For Tray 1, load the letterhead paper face-up with
the top edge feeding into the product first.

◦ For all other trays, load the letterhead paper face-
down with the top edge at the front of the tray.

3. In the printer driver, click Print on both sides. If you will
bind the document along the top edge, click Flip pages
up.

4. Click the OK button to print the job.

Print a booklet (duplex models only) 1. Set the product for the correct width of paper that you are
using. At the back of the product, lift the duplex jam-
release door, and locate the blue paper-width selection
lever.

◦ Letter and Legal-size paper: Push the lever in.

◦ A4-size paper: Pull the lever out.
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How do I Steps to perform

2. In the printer driver, click Print on both sides.

3. In the Booklet layout drop-down list, click Left binding
or Right binding. The Pages per sheet option
automatically changes to 2 pages per sheet.

4. Click the OK button to print the job.

Print multiple pages per sheet a) Select the number of pages per sheet from the Pages per
sheet drop-down list. b) Select the correct options for Print
page borders, Page order, and Orientation.

Select page orientation a) In the Orientation area, click Portrait or Landscape. b) To
print the page image upside down, click Rotate by 180
degrees.

Obtain support and product-status information
To perform the following tasks, open the printer driver and click the Services tab.

How do I Steps to perform

Obtain support information for the product and order supplies
online

In the Internet Services drop-down list, select a support
option, and click Go!

Check the status of the product, including the level of supplies Click the Device and Supplies Status icon. The Device
Status page of the HP embedded Web server opens.
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Set advanced printing options
To perform the following tasks, open the printer driver and click the Advanced tab.

How do I Steps to perform

Select advanced printing options In any of the sections, click a current setting to activate a drop-
down list so you can change the setting.

Change the number of copies that are printed

NOTE: If the software program that you are using does not
provide a way to print a particular number of copies, you can
change the number of copies in the driver.

Changing this setting affects the number of copies for all print
jobs. After your job has printed, restore this setting to the
original value.

Open the Paper/Output section, and then enter the number of
copies to print. If you select 2 or more copies, you can select
the option to collate the pages.

Load letterhead or preprinted paper the same way for every
job, whether printing on one or both sides of the page

a) Open the Document Options section, and then open the
Printer Features section. b) In the Alternative Letterhead
Mode drop-down list, select On. c) At the product, load the
paper the same way you would for printing on both sides.

Change the order in which pages are printed a) Open the Document Options section, and then open the
Layout Options section. b) In the Page Order drop-down list,
select Front to Back to print the pages in the same order as
they are in the document, or select Back to Front to print the
pages in the reverse order.
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9 Manage and maintain the product

● Print the information pages

● Use the HP ToolboxFX software

● Manage a network product

● Lock the product

● Manage supplies

● Replace supplies and parts

● Install memory

● Clean the product
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Print the information pages
From the product control panel, you can print information pages that give details about the product and
its current configuration using the Reports menu.

Name of report Description

Demo page Prints a page that demonstrates print quality.

Menu structure Prints the control-panel menu map that shows the layout and
current settings for the control-panel menu items.

Config report Prints the current product configuration.

Supplies status Prints a supplies status page that shows the supplies levels for
the product, an approximate number of pages remaining,
cartridge-usage information, the serial number, a page count,
and ordering information, when available.

Network Report Prints a list of all product network settings.

Usage Page Prints a page that shows a count of all paper sizes that have
passed through the product, lists whether they were one-sided
or two-sided (duplex models only), and shows a page count.

PCL Font List Prints a PCL font list that shows all the PCL fonts that are
currently available to the product.

PS font list Prints a PS font list that shows all the PS fonts that are currently
available to the product.

PCL 6 Font List Prints a list of all the PCL6 fonts that are installed.

Service Page Prints the service report.

Print the information pages

1. Press OK.

2. Press the down arrow  to select Reports, and then press OK.

3. Press the down arrow  to select the required report, and then press OK to print.

70 Chapter 9   Manage and maintain the product ENWW



Use the HP ToolboxFX software
HP ToolboxFX is a program that you can use to complete the following tasks:

● Check the product status.

● Configure the product settings.

● View troubleshooting information.

● View online documentation.

You can view HP ToolboxFX when the product is directly connected to a computer or when it is
connected to the network. You must perform the recommended full software installation to use
HP ToolboxFX.

View HP ToolboxFX
Open HP ToolboxFX in one of these ways:

● In the Windows system tray or on your desktop, double-click the HP ToolboxFX icon.

● On the Windows Start menu, click Programs (or All Programs in Windows XP), click HP, click
HP LaserJet P2050 Series, and then click HP ToolboxFX.
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Status
The Status folder contains links to the following main pages:

● Device status. This page indicates product conditions such as a jam or an empty tray. After you
correct a problem, click Refresh status to update the product status.

● Supplies status. View details such as the estimated percent of toner remaining in the print
cartridge and the number of pages that have been printed with the current print cartridge. This page
also has links for ordering supplies and for finding recycling information.

● Device configuration. View a detailed description of the current product configuration, including
the amount of memory installed and whether optional trays are installed.

● Network summary. View a detailed description of the current network configuration, including the
IP address and network status.

● Print info pages. Print the Configuration page and other information pages, such as the Supplies
status page.

● Event log. View a history of product errors. The most recent error is listed first.

Event log
The Event log is a table that contains codes corresponding to error messages that have appeared on
the product control-panel display, a brief description of each error, and the number of pages that printed
when each error occurred. For more information about error messages, see Interpret control-panel
messages on page 102.
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Alerts
The Alerts folder contains links to the following main pages:

● Set up Status Alerts. Set up the product to send you pop-up alerts for certain events, such as low
toner levels.

● Set up E-mail Alerts. Set up the product to send you e-mail alerts for certain events, such as low
toner levels.

Set up Status Alerts
Use this to set up the product so that it sends alerts to your computer when jams, low levels of toner in
HP print cartridges, a non-HP print cartridge in use, empty input trays, and specific error messages
occur.

Select to receive a pop-up, a system tray icon, a desktop alert, or any combination of these. The pop-
up and desktop alerts only appear when the product is printing from the computer on which you set up
the alerts. Desktop alerts are only visible momentarily, and disappear automatically.

Change the Cartridge low threshold setting, which sets the toner level that causes a low toner alert,
on the System setup page.

NOTE: You must click Apply before your changes take effect.

Set up E-mail Alerts
Use this to configure up to two e-mail addresses to receive alerts when certain events occur. You can
specify different events for each e-mail address. Use the information for the e-mail server that will send
out the e-mail alert messages for the product.

NOTE: You can only configure e-mail alerts to be sent from a server that does not require user
authentication. If your e-mail server requires you to log in with a username and password, you cannot
enable e-mail alerts.

NOTE: You must click Apply before your changes take effect.

Help
The Help folder contains links to the following main pages:

● Troubleshooting. View troubleshooting help topics, print troubleshooting pages, and clean the
product.

● Paper and Print Media. Print information about how to obtain optimal results from your product
using various types of paper and print media.

● How do I? Link to the user-guide index.

● User Guide. View information about the product usage, warranty, specifications, and support. The
User Guide is available in both HTML and PDF format.
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Device Settings
The Device Settings folder contains links to the following main pages:

● Device Information. View information such as the product description and a contact person.

● Paper Handling. Configure trays or change the product paper-handling settings, such as default
paper size and default paper type.

● Printing. Change the default product print settings, such as number of copies and paper
orientation.

● PCL 5. Change the PCL settings.

● PostScript. Change the PS settings.

● Paper Types. Change the mode settings for each media type, such as letterhead, prepunched, or
glossy paper.

● System Setup. Change the system settings, such as jam recovery and auto-continue. Change the
Cartridge low threshold setting, which sets the toner level that causes a low toner alert.

● Troubleshooting. Gain access to various procedures required to maintain the product.

● Password. Set a password to protect the device settings. Once a password is set, users will be
prompted to enter the password before being allowed to change device settings. This password is
the same as the embedded Web server password.

Device Information
The Device Information page stores data about your product for future reference. The information that
you type in the fields on this page appears on the Configuration page. You can type any character in
each of these fields.

NOTE: You must click Apply before your changes take effect.
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Paper Handling
Use these options to configure your default settings. These are the same options that are available on
the control-panel menus on the control panel. For more information, see Use the control-panel menus
on page 11.

The following options are available for handling print jobs when the product is out of media:

● Select Wait for paper to be loaded.

● Select Cancel from the Paper out action drop-down list to cancel the print job.

● Select Override from the Paper out time drop-down list to send the print job to another paper tray.

The Paper out time field specifies how long the product waits before acting on your selections. You
can specify from 0 to 3600 seconds.

NOTE: You must click Apply before your changes take effect.

Printing
Use these options to configure the settings for all print functions. These are the same options that are
available on the control panel. For more information, see Use the control-panel menus on page 11.

NOTE: You must click Apply before your changes take effect.

PCL5c
Use these options to configure the settings when you are using the PCL print personality.

NOTE: You must click Apply before your changes take effect.

PostScript
Use this option when you are using the PostScript print personality. When the Print PostScript error
option is turned on, the PostScript error page automatically prints when PostScript errors occur.

NOTE: You must click Apply before your changes take effect.

Print quality
Use the HP ToolboxFX print-quality options to improve the appearance of print jobs. These are the same
options that are available on the product control panel. For more information, see Use the control-panel
menus on page 11.

The four options provided for controlling print quality are resolution, REt (Resolution Enhancement
technology), print density, and EconoMode.

● Resolution. Select 600 resolution for average print jobs and Fast Res 1200 for higher-quality print
jobs. Select ProRes 1200 for the highest-quality print job, but a longer printing time.

● REt. You can turn on REt, which HP provides for improved print quality.

● Print density. For increased print density, select a higher number. For decreased print density,
select a lower number.

● EconoMode. Turn EconoMode on when you are printing average print jobs. EconoMode is a
feature that allows the product to use less toner per page. Selecting this option might extend the
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life of the toner supply and might reduce cost per page. However, it will also reduce print quality.
The printed image is lighter, but it is adequate for printing drafts or proofs. HP does not recommend
full-time use of EconoMode. If EconoMode is used full-time, it is possible that the toner supply will
outlast the mechanical parts in the print cartridge. If print quality begins to degrade under these
circumstances, you will need to install a new print cartridge, even if there is toner supply remaining
in the cartridge.

NOTE: You must click Apply before the changes take effect.

Paper Types
Use these options to configure print modes that correspond to the various media types. To reset all
modes to factory default settings, select Restore modes.

NOTE: You must click Apply before your changes take effect.

System Setup
Use these system settings to configure miscellaneous print settings. These settings are not available
on the control panel.

NOTE: You must click Apply before your changes take effect.

Troubleshooting
During the printing process, paper, toner and dust particles can accumulate inside the product. Over
time, this buildup can cause print-quality problems such as toner specks or smearing. The HP ToolboxFX
provides an easy method for cleaning the paper path. For more information, see Clean the paper path
on page 91.

Network Settings
The network administrator can use this tab to control the network-related settings for the product when
it is connected to an IP-based network.

Shop for Supplies
This button, at the top of each page, links to a Web site where you can order replacement supplies. You
must have Internet access to use this feature.

Other Links
This section contains links that connect you to the Internet. You must have Internet access in order to
use any of these links. If you use a dial-up connection and did not connect when you first opened
HP ToolboxFX, you must connect before you can visit these Web sites. Connecting might require that
you close HP ToolboxFX and reopen it.

● HP Instant Support. Connects to the HP Instant Support Web site.

● Support and Troubleshooting. Connects to the support site for the product where you can search
for help with a specific problem.

● Product Registration. Connects to the HP product registration Web site.
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Manage a network product
Embedded Web server

The embedded Web server allows you to view product and network status and to manage printing
functions from your computer. Use the embedded Web server for the following tasks:

● View product status information

● Determine the remaining life on all supplies and order new ones

● View and change the size and type of paper loaded in each tray

● View and change the product default configuration settings

● View and change network configuration

You do not need to install any software on the computer. Use one of these supported Web browsers:

● Internet Explorer 6.0 (and later)

● Netscape Navigator 7.0 (and later)

● Firefox 1.0 (and later)

● Mozilla 1.6 (and later)

● Opera 7.0 (and later)

● Safari 1.2 (and later)

● Konqueror 3.2 (and later)

The embedded Web server works when the product is connected to a TCP/IP-based network. The
embedded Web server does not support IPX-based connections or direct USB connections.

NOTE: You do not have to have Internet access to open and use the embedded Web server. However,
if you click a link on any of the pages, you must have Internet access in order to go to the site associated
with the link.

Open the embedded Web server
To open the embedded Web server, type the IP address or hostname of the product in the address field
of a supported Web browser.

TIP: After you open the URL, bookmark it so that you can return to it quickly in the future.

The embedded Web server has three tabs that contain settings and information about the product: the
Status tab, the Settings tab, and the Networking tab.

Status tab
This tab provides information about product and supplies status, product and network configuration, and
supplies reordering.

ENWW Manage a network product 77



Settings tab
This tab allows you to configure the product from your computer. If this product is networked, consult
with the network administrator before changing settings on this tab.

Networking tab
This tab allows the network administrator to control network-related settings for the product when it is
connected to an IP-based network.

Links
Links are located in the upper-right part of the Status pages. You must have Internet access in order to
use any of these links. If you use a dial-up connection and did not connect when you first opened the
embedded Web server, you must connect before you can visit these Web sites. Connecting might
require that you close the embedded Web server and reopen it.

● Order Supplies. Click this link to connect to the Sure Supply Web site and order genuine
HP supplies from HP or a reseller of your choice.

● Product Support. Click this link to connect to the support site for the product. You can search for
help regarding general topics.

Use HP Web Jetadmin software
HP Web Jetadmin is a Web-based software solution for remotely installing, monitoring, and
troubleshooting network-connected peripherals. The intuitive browser interface simplifies cross-platform
management of a wide range of devices, including HP and non-HP devices. Management is proactive,
allowing network administrators the ability to resolve issues before users are affected. Download this
free, enhanced-management software at www.hp.com/go/webjetadmin_software. 

To obtain plug-ins to HP Web Jetadmin, click plug-ins, and then click the download link that is next to
the name of the plug-in that you want. The HP Web Jetadmin software can automatically notify you
when new plug-ins are available. On the Product Update page, follow the directions to automatically
connect to the HP Web site.

If installed on a host server, HP Web Jetadmin is available to any client through a supported Web
browser, such as Microsoft Internet Explorer 6.0 for Windows or Netscape Navigator 7.1 for Linux.
Browse to the HP Web Jetadmin host.

NOTE: Browsers must be Java™-enabled. Browsing from an Apple PC is not supported.

Use security features
The product supports security standards and recommended protocols that help you keep the product
secure, protect critical information on your network, and simplify the way you monitor and maintain the
product.

For in-depth information about HP's secure imaging and printing solutions, visit www.hp.com/go/
secureprinting. The site provides links to white papers and FAQ documents about security features.

Secure the embedded Web server
You can configure the embedded Web server so that access to some tabs requires a password.

See Set or change the network password on page 39.
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Lock the product
The product has a slot that you can use to attach a cable-type security lock.
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Manage supplies
Using, storing, and monitoring the print cartridge can help ensure high-quality output.

Supplies life
For information regarding specific product yield, see www.hp.com/go/learnaboutsupplies.com.

To order supplies, see Supplies and accessories on page 131.

Manage the print cartridge

Print-cartridge storage
Do not remove the print cartridge from its package until you are ready to use it.

CAUTION: To prevent damage to the print cartridge, do not expose it to light for more than a few
minutes.

Use genuine HP print cartridges
When you use a genuine new HP print cartridge, you can obtain the following supplies information:

● Percentage of supplies remaining

● Estimated number of pages remaining

● Number of pages printed

HP policy on non-HP print cartridges
Hewlett-Packard Company cannot recommend the use of non-HP print cartridges, either new or
remanufactured.

NOTE: Any damage caused by a non-HP print cartridge is not covered under the HP warranty and
service agreements.

To install a new HP print cartridge, see Change the print cartridge on page 83. To recycle the used
cartridge, follow the instructions included with the new cartridge.

Print-cartridge authentication
The device automatically authenticates the print cartridge when it is inserted into the device. During
authentication, the device notifies you whether a cartridge is a genuine HP print cartridge.

If the device control-panel message states that this is not a genuine HP print cartridge and you believe
you purchased an HP print cartridge, see HP fraud hotline and Web site on page 80.

HP fraud hotline and Web site
Call the HP fraud hotline (1-877-219-3183, toll-free in North America) or go to www.hp.com/go/
anticounterfeit when you install an HP print cartridge and the control-panel message says the cartridge
is non-HP. HP will help determine if the cartridge is genuine and take steps to resolve the problem.
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Your print cartridge might not be a genuine HP print cartridge if you notice the following:

● You are experiencing a high number of problems with the print cartridge.

● The cartridge does not look like it usually does (for example, the orange pull tab is missing, or the
packaging differs from HP packaging).
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Replace supplies and parts
Supply replacement guidelines

Keep the following guidelines in mind when setting up the product.

● Sufficient space is required above and in the front of the product for removing supplies.

● The product should be located on a flat, sturdy surface.

NOTE: Hewlett-Packard recommends the use of HP supplies in this product. Use of non-HP supplies
can cause problems requiring service that is not covered by the HP warranty or service agreements.

Redistribute toner
When toner is low, faded or light areas appear on the printed page. You might be able to temporarily
improve print quality by redistributing the toner.

1. Push the button to open the print-cartridge door, and then remove the print cartridge.

2. To redistribute the toner, gently rock the print cartridge from front to back.

CAUTION: If toner gets on your clothing, wipe it off with a dry cloth and wash the clothing in cold
water. Hot water sets toner into the fabric.
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3. Reinsert the print cartridge into the product, and then close the print-cartridge door.

If the print is still light, install a new print cartridge.

Change the print cartridge
When a print cartridge approaches the end of useful life, you are prompted to order a replacement. You
can continue printing with the current cartridge until redistributing the toner no longer yields acceptable
print quality.

1. Push the button to open the print-cartridge door, and then remove the print cartridge.

2. Remove the new print cartridge from the bag. Place the used print cartridge in the bag for recycling.
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3. Grasp both sides of the print cartridge and distribute the toner by gently rocking the print cartridge.

CAUTION: Do not touch the shutter or the surface of the roller.

4. Bend the tab on the left side of the cartridge until the tab breaks loose. Pull the tab until all the tape
is removed from the cartridge. Place the tab and tape in the print-cartridge box to return for
recycling.

5. Align the print cartridge with the tracks inside the product, insert the print cartridge until it is firmly
seated, and then close the print-cartridge door.

6. Installation is complete. Place the used print cartridge in the box in which the new cartridge arrived.
See the enclosed recycling guide for recycling instructions.

For additional help, go to www.hp.com/support/ljp2050series.
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Install memory
NOTE: Single inline memory modules (SIMMs) used in previous HP LaserJet products are not
compatible with the product.

Install product memory
This product has one DIMM slot.

CAUTION: Static electricity can damage DIMMs. When handling DIMMs, either wear an antistatic
wrist strap or frequently touch the surface of the DIMM antistatic package, then touch bare metal on the
product.

If you have not already done so, print a configuration page to find out how much memory is installed in
the product before adding more memory. See Print the information pages on page 70.

1. After the configuration page has printed, turn the product off and disconnect the power cord.

2. Disconnect all interface cables.
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3. Open the DIMM-access door on the left side of the product.

4. Remove the DIMM from the antistatic package.

CAUTION: To reduce the possibility of damage caused by static electricity, always wear an
electrostatic discharge (ESD) wrist strap or touch the surface of the antistatic package before
handling DIMMs.

5. Hold the DIMM by the edges, and align the notches on the DIMM with the DIMM slot. (Check that
the locks on each side of the DIMM slot are open.)
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6. Hold the DIMM at a 45-degree angle, and then push the upper contacts of the DIMM firmly into the
slot. Make sure that the locks on each side of the DIMM snap into place.

CAUTION: Pressing the DIMM straight down will damage the contact pins.

NOTE: To remove a DIMM, first release the locks.
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7. Close the access door, and press firmly until it snaps into place.

8. Reconnect the interface cables and the power cord.

9. Turn the product on.

Check DIMM installation
After installing the DIMM, make sure that the installation was successful.

1. Turn the product on. Check that the Ready light is illuminated after the product has gone through
the startup sequence. If an error message appears, a DIMM might have been incorrectly installed.
See Interpret control-panel messages on page 102.

2. Print a configuration page (see Print the information pages on page 70).

3. Check the memory section on the configuration page and compare it to the configuration page that
was printed before the memory installation. If the amount of memory has not increased, the DIMM
might not be installed correctly, or the DIMM might be defective. Repeat the installation procedure.
If necessary, install a different DIMM.

NOTE: If you installed a product language (personality), check the "Installed Personalities and
Options" section on the configuration page. This area should list the new product language.

Save resources (permanent resources)
Utilities or jobs that you download to the product sometimes include resources (for example, fonts,
macros, or patterns). Resources that are internally marked as permanent remain in the product memory
until you turn the product off.
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Use the following guidelines if you use the page description language (PDL) ability to mark resources
as permanent. For technical details, see an appropriate PDL reference for PCL or PS.

● Mark resources as permanent only when it is absolutely necessary that they remain in memory
while the product is turned on.

● Send permanent resources to the product only at the beginning of a print job and not while the
product is printing.

NOTE: Overusing permanent resources or downloading them while the product is printing might affect
product performance or the ability to print complex pages.

Enable memory for Windows
1. Windows XP and Windows Server 2003 (using the default Start menu view): Click Start, click

Settings, and then click Printers and Faxes.

-or-

Windows 2000, Windows XP, and Windows Server 2003 (using the Classic Start menu
view): Click Start, click Settings, and then click Printers.

-or-

Windows Vista: Click Start, click Control Panel, and then in the category for Hardware and
Sound click Printer.

2. Right-click the driver icon, and then select Properties.

3. Click the Device Settings tab.

4. Expand the area for Installable Options.

5. Next to Printer Memory, select the total amount of memory that is installed.

6. Click OK.
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Clean the product
Clean the outside of the printer with a clean, damp cloth when necessary.

CAUTION: Do not use ammonia-based cleaners on or around the printer.

During the printing process, paper, toner, and dust particles can accumulate inside the printer. Over
time, this buildup can cause print quality problems, such as toner specks or smearing, and paper jams.
To correct and prevent these types of problems, you can clean the print cartridge area and the printer
media path.

Clean the print-cartridge area
You do not need to clean the print-cartridge area often. However, cleaning this area can improve the
quality of your printed sheets.

WARNING! To avoid injury, turn the product off, disconnect the power cord, and wait for the product
to cool before cleaning it.

1. Open the print-cartridge door, and then remove the print cartridge.

CAUTION: Do not touch the black sponge-transfer roller inside the product. Doing so can
damage the product.

CAUTION: To prevent damage, do not expose the print cartridge to light. Cover it with a piece
of paper.

2. With a dry, lint-free cloth, wipe any residue from the media-path area and the print-cartridge cavity.
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3. Replace the print cartridge, and close the print-cartridge door.

4. Reconnect the power cord, and turn the product on.

Clean the paper path
During the printing process, paper, toner, and dust particles can accumulate inside the product. Over
time, this buildup can cause print-quality problems such as toner specks or smearing. This product has
a cleaning mode that can correct and prevent these problems.

1. Open HP ToolboxFX. See View HP ToolboxFX on page 71.

2. Click the Device Settings folder, and then click the Troubleshooting page.

3. In the area for Cleaning Mode, click Start to begin the cleaning process.

The product processes a single page, and then returns to the Ready state when the cleaning
process is complete.
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Clean the Tray 1 pickup roller
If the product is having trouble picking up paper from Tray 1, follow these instructions.

1. Turn the product off, disconnect the power cord, and wait for the product to cool.
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2. Push the button to open the print-cartridge door, and then remove the print cartridge.

CAUTION: Do not touch the black sponge-transfer roller inside the product. Doing so can
damage the product.

CAUTION: To prevent damage, do not expose the print cartridge to light. Cover it with a piece
of paper.

3. Lift the pickup roller cover.
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4. Press the two black retaining tabs outward until the pickup roller is released from its seat.

5. Remove the pickup roller from the product.

6. Dab a lint-free cloth in water, and scrub the roller.

NOTE: Do not touch the surface of the roller with bare fingers.

7. Using a dry, lint-free cloth, wipe the pickup roller to remove loosened dirt.
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8. Allow the pickup roller to dry completely.

9. Line up the black retaining tabs in the product with the grooves in the pickup roller, and then press
the pickup roller into the pickup roller seat until the retaining tabs click.

10. Close the pickup roller cover.

11. Reinstall the print cartridge, and close the print-cartridge door.
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12. Reconnect the power cord, and turn the product on.

Clean the Tray 2 pickup roller
If the product is having trouble picking up paper from Tray 2, follow these instructions.

1. Turn the product off, disconnect the power cord and wait for the product to cool.
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2. Remove Tray 2.
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3. Inside the empty tray slot, locate the pickup roller on the top side, near the front of the product.

4. Dab a lint-free cloth in water, and then scrub the roller as you rotate it toward the back of the product.

NOTE: Do not touch the surface of the roller with bare fingers.

5. Using a dry, lint-free cloth, wipe the pickup roller to remove loosened dirt.

6. Allow the pickup roller to dry completely.

7. Replace Tray 2.
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8. Reconnect the power cord, and turn the product on.
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10 Solve problems

● Solve general problems

● Restore factory settings

● Interpret control-panel messages

● Jams

● Solve print-quality problems

● Solve performance problems

● Solve connectivity problems

● Solve common Windows problems 

● Solve common Macintosh problems

● Solve Linux problems
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Solve general problems
If the product is not responding correctly, complete the steps in the following checklist, in order. If the
product does not pass a step, follow the corresponding troubleshooting suggestions. If a step resolves
the problem, you can stop without performing the other steps on the checklist.

Troubleshooting checklist
1. Make sure the product Ready light is on. If no lights are on, complete these steps:

a. Check the power-cable connections.

b. Check that the power switch is on.

c. Make sure that the line voltage is correct for the product power configuration. (See the label
that is on the back of the product for voltage requirements.) If you are using a power strip and
its voltage is not within specifications, plug the product directly into the wall. If it is already
plugged into the wall, try a different outlet.

d. If none of these measures restores power, contact HP Customer Care.

2. Check the cabling.

a. Check the cable connection between the product and the computer or network port. Make
sure that the connection is secure.

b. Make sure that the cable itself is not faulty by using a different cable, if possible.

c. Check the network connection. See Solve network problems on page 124.

3. Check to see if any messages appear on the control-panel display. If any error messages appear,
see Interpret control-panel messages on page 102.

4. Ensure that the paper that you are using meets specifications.

5. Print a configuration page. See Print the information pages on page 70. If the product is connected
to a network, an HP Jetdirect page also prints.

a. If the pages do not print, check that at least one tray contains paper.

b. If the page jams in the product, see Clear jams on page 107.

6. If the configuration page prints, check the following items.

a. If the page does not print correctly, the problem is with the product hardware. Contact
HP Customer Care.

b. If the page prints correctly, then the product hardware is working. The problem is with the
computer you are using, with the printer driver, or with the program.

7. Select one of the following options:

Windows: Click Start, click Settings, and then click Printers, or Printers and Faxes. Double-
click the name of the product.

-or-

Mac OS X: Open Print Center or Printer Setup Utility, and double-click the line for the product.
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8. Verify that you have installed the printer driver for this product. Check the program to make sure
that you are using the printer driver for this product.

9. Print a short document from a different program that has worked in the past. If this solution works,
then the problem is with the program you are using. If this solution does not work (the document
does not print) complete these steps:

a. Try printing the job from another computer that has the product software installed.

b. If you connected the product to the network, connect the product directly to a computer with
a USB cable. Redirect the product to the correct port, or reinstall the software, selecting the
new connection type that you are using.

Factors that affect product performance
Several factors affect the time it takes to print a job:

● Maximum product speed, measured in pages per minute (ppm)

● The use of special paper (such as transparencies, heavy paper, and custom-size paper)

● Product processing and download time

● The complexity and size of graphics

● The speed of the computer you are using

● The USB connection

● The printer I/O configuration

● The amount of memory installed in the product

● The network operating system and configuration (if applicable)

NOTE: Although additional memory can improve how the product handles complex graphics and
improve download times, it will not increase maximum product speed (ppm).

Restore factory settings
Use the Restore defaults menu to restore factory settings.

1. Press OK.

2. Press the down arrow  to select Service, and then press OK.

3. Press the down arrow  to select Restore defaults, and then press OK.
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Interpret control-panel messages
The control-panel messages indicate the current product status or situations that might require action.

Control-panel messages appear temporarily and might require that you acknowledge the message by
pressing OK to resume printing or by pressing X to cancel the job. With certain messages, the job might
not finish printing or the print quality might be affected. If the message is related to printing and the auto-
continue feature is on, the product will attempt to resume printing after the message has appeared for
10 seconds without acknowledgement.

For some messages, restarting the product might fix the problem. If a critical error persists, the product
might require service.

Control-panel messages

Control-panel message Description Recommended action

10.X Supply memory error The e-label for the print cartridge cannot be
read or is missing.

Reinstall the print cartridge.

Turn the product off and then on.

If the problem is not solved, replace the
cartridge.

Press OK to override this error and continue
to print. Supplies and status features are not
available.

13.XX Jam in <location> The product has detected a jam. Clear the jam from the location indicated. The
job should continue to print. If it does not, try
reprinting the job.

If the message persists, contact HP support.
See Customer support on page 141.

21.X Print failure

Press [OK]

If error repeats turn off then on

The product cannot process the page. Press OK to continue printing the job, but
output might be affected.

If the error persists, turn the power off and
then on. Resend the print job.

41.2 Engine error

Press [OK]

The engine experienced an internal error. Turn the product power off, wait at least
30 seconds, and then turn the product power
on and wait for it to initialize.

If you are using a surge protector, remove it.
Plug the product directly into the wall socket.
Turn the product power on.

If the message persists, contact HP support.
See Customer support on page 141.

41.3 Unexpected size in tray x

Load <SIZE>

Press [OK]

The product has detected print media in the
tray that does not match the configuration for
the tray.

Load the correct media into the tray, or
configure the tray for the size that you have
loaded. See Load trays on page 50.
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Control-panel message Description Recommended action

49 Error

Turn off then on

The product experienced an internal error. Turn the product off, wait at least 30 seconds,
and then turn the product on and wait for it to
initialize.

If you are using a surge protector, remove it.
Plug the product directly into the wall socket.
Turn the product power on.

If the message persists, contact HP support.
See Customer support on page 141.

50.X Fuser error

Turn off then on

The product has experienced an error with
the fuser.

Turn the product power off, wait at least
30 seconds, and then turn the product power
on and wait for it to initialize.

Turn off the product, wait at least 25 minutes,
and then turn on the product.

If you are using a surge protector, remove it.
Plug the product directly into the wall socket.
Turn the product power on.

If the message persists, contact HP support.
See Customer support on page 141.

51.XX Error

Turn off then on

The product has experienced an internal
hardware error.

Turn the product power off, wait at least
30 seconds, and then turn the product power
on and wait for it to initialize.

If you are using a surge protector, remove it.
Plug the product directly into the wall socket.
Turn the product on.

If the message persists, contact HP support.
See Customer support on page 141.

55.X Error

Turn off then on

The product has experienced an internal
error.

Turn the product power off, wait at least
30 seconds, and then turn the product power
on and wait for it to initialize.

If you are using a surge protector, remove it.
Plug the product directly into the wall socket.
Turn the product power on.

If the message persists, contact HP support.
See Customer support on page 141.

57 Fan error

Turn off then on

The product has experienced a problem with
its internal fan.

Turn the product power off, wait at least
30 seconds, and then turn the product power
on and wait for it to initialize.

If you are using a surge protector, remove it.
Plug the product directly into the wall socket.
Turn the product power on.

If the message persists, contact HP support.
See Customer support on page 141.
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Control-panel message Description Recommended action

79 Error

Turn off then on

The product has experienced an internal
firmware error.

Turn the product power off, wait at least
30 seconds, and then turn the product power
on and wait for it to initialize.

If you are using a surge protector, remove it.
Plug the product directly into the wall socket.
Turn the product power on.

If the message persists, contact HP support.
See Customer support on page 141.

79 Service error

Turn off then on

An incompatible DIMM is installed. 1. Turn the product power off.

2. Install a DIMM that the product
supports. See Supplies and accessories
on page 131 for a list of supported
DIMMs. See Install memory
on page 85 for DIMM installation
instructions.

3. Turn the product on.

If the message persists, contact HP support.
See Customer support on page 141.

Device error

Press [OK]

An internal error occurred. Press OK to resume the job.

Door open The product door is open. Close the door.

Genuine HP supply installed A genuine HP supply was installed. This
message will appear briefly after the supply
is installed and then be replaced by the
message Ready.

No action necessary.

Install black cartridge The cartridge is either not installed or not
correctly installed in the product.

Install the print cartridge. See Change the
print cartridge on page 83.

Load paper The product is out of paper. Load paper into a tray.

Load tray # <TYPE> <SIZE>

Press [OK] for available media

A tray is configured for the media type and
size that the print job is requesting, but that
tray is empty.

Load the correct media into the tray, or press
OK to use media in a different tray.

Load tray 1 plain <SIZE>

Cleaning mode [OK] to start

The product is ready to process the cleaning
operation.

Load Tray 1 with plain paper in the size
indicated, and then press OK.

Load tray 1 <TYPE> <SIZE>

Press [OK] for available media

No trays are configured for the media type
and size that the print job is requesting.

Load the correct media into tray 1, or press
OK to use media in a different tray.

Manual duplex

Load tray x

Press [OK]

The first side of a manual duplex job has
printed, and the page needs to be loaded to
process the second side.

Load the page in the indicated tray with the
side to be printed face up, and the top of the
page away from you and then press OK.

Manual feed <TYPE> <SIZE>

Press [OK] for available media

The product is set for manual feed mode. Press OK to clear the message or load the
correct media into tray 1.
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Control-panel message Description Recommended action

Memory is low

Press [OK]

The product memory is almost full. Press OK to finish the job, or press the Cancel
button  to cancel the job.

For information about increasing the product
memory, see Install memory on page 85.

Misprint

Press [OK]

Print media has been delayed as it moves
through the product.

Press OK to clear the message.

Non-HP supply installed A non-HP supply is installed. If you believe you purchased an HP supply,
go to www.hp.com/go/anticounterfeit.

Service or repairs that are required as a result
of using non-HP supplies are not covered
under HP warranty.

Order black cartridge

Ready

The print cartridge is nearing the end of its
useful life.

Order a new print cartridge. You can continue
printing with the current print cartridge until
redistributing the toner no longer yields
acceptable print quality.

See Supplies and accessories on page 131
for more information.

Output bin full

Remove all paper from bin

The output bin is full. Remove all paper from the bin.

Rear door open The product rear door is open. Close the door.

Remove shipping lock from black
cartridge

A print cartridge shipping lock is installed. Be sure that the print cartridge shipping lock
has been removed.

Used cartridge in use A refilled print cartridge was detected and
accepted.

No action necessary.

Used cartridge installed

To accept press [OK]

A refilled print cartridge is installed. Press OK to continue.
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Jams
Common causes of jams

Many jams are caused by using paper that does not meet HP specifications. For complete paper
specifications for all HP LaserJet products, see the HP LaserJet Printer Family Print Media Guide. This
guide is available at www.hp.com/support/ljpaperguide.

The product is jammed.1

Cause Solution

The paper does not meet specifications. Use only paper that meets HP specifications. See Paper and
print media on page 43.

A component is installed incorrectly. Verify that the print cartridge is correctly installed.

You are using paper that has already passed through a product
or copier.

Do not use paper that has been previously printed on or copied.

A tray is loaded incorrectly. Remove any excess paper from the tray. Make sure that the
stack is below the maximum stack height mark in the tray. See
Load trays on page 50.

The paper is skewed. The tray guides are not adjusted correctly. Adjust them so they
hold the stack firmly in place without bending it.

The paper is binding or sticking together. Remove the paper, flex it, rotate it 180°, or flip it over. Reload
the paper into the tray.

NOTE: Do not fan paper. Fanning can create static
electricity, which can cause paper to stick together.

The paper is removed before it settles into the output bin. Reset the product. Wait until the page completely settles in the
output bin before removing it.

During two-sided printing, you removed the paper before the
second side of the document was printed.

Reset the product and print the document again. Wait until the
page completely settles in the output bin before removing it.

The paper is in poor condition. Replace the paper.

The internal rollers from the tray are not picking up the paper. Remove the top sheet of paper. If the paper is too heavy, it
might not be picked from the tray.

The paper has rough or jagged edges. Replace the paper.

The paper is perforated or embossed. Perforated or embossed paper does not separate easily. Feed
single sheets from Tray 1.

Product supply items have reached the end of their useful life. Check the product control panel for messages prompting you
to replace supplies, or print a supplies status page to verify the
remaining life of the supplies. See Print the information
pages on page 70.

Paper was not stored correctly. Replace the paper in the trays. Paper should be stored in the
original packaging in a controlled environment.

1 If the product continues to jam, contact HP Customer Support or your authorized HP service provider.
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Jam locations
Jams can occur at the following locations in the product.

1

3 2

1 Internal areas

2 Input trays

3 Output bins

Clear jams
When clearing jams, be careful not to tear jammed paper. If a small piece of paper remains in the product,
it could cause additional jams.

CAUTION: Before clearing jams, turn the product off and disconnect the power cord.

Internal areas

Print-cartridge area and paper path

1. Push the button to open the print-cartridge door, and then remove the print cartridge.

CAUTION: To prevent damage, do not expose the print cartridge to light. Cover it with a piece
of paper.
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2. If jammed paper is visible, grasp it with both hands and slowly pull it out of the product.

3. Replace the print-cartridge, and close the print-cartridge door.

4. If no paper was jammed inside the print-cartridge door, open the jam-release door at the back of
the product.
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5. If jammed paper is visible, grasp it with both hands and slowly pull it out of the product.

6. Close the jam-release door.

Duplex paper path (duplex models only)

1. At the front of the product, remove Tray 2.
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2. Push down on the green lever to release the duplex paper-path door on the front of the product.

3. Check for jammed paper at the front of the product. With both hands, grasp the jammed paper and
slowly pull it out of the product.

4. Push up on the duplex paper-path door to close it.
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5. Replace Tray 2.

6. Open the duplex jam-release door on the back of the product.

7. Check for jammed paper at the back of the product. With both hands, grasp the jammed paper and
slowly pull it out of the product.
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8. Close the jam-release door.

Input trays

Tray 1

1. Push the button to open the print-cartridge door, and then remove the print cartridge.

CAUTION: To prevent damage, do not expose the print cartridge to light. Cover it with a piece
of paper.

2. Lift the Tray 1 roller cover, grasp the jammed paper, and slowly pull it out of the product.
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3. Replace the print-cartridge, and close the print-cartridge door.

Tray 2

1. Open the tray.

2. With both hands, grasp the jammed paper and slowly pull it out of the product.
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3. Close the tray.

4. If no jammed paper is visible in the tray area, open the print-cartridge door, remove the print
cartridge, and pull down the upper media guide. With both hands, grasp the jammed paper and
slowly pull it out of the product.

5. Replace the print-cartridge, and close the print-cartridge door.
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Tray 3

1. Remove Tray 2 and Tray 3.

2. With both hands, grasp the jammed paper and slowly pull it out of the product.

3. Replace the trays.
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4. If no jammed paper is visible in the tray area, open the print-cartridge door, remove the print
cartridge, and pull down the upper media guide. With both hands, grasp the jammed paper and
slowly pull it out of the product.

5. Replace the print-cartridge, and close the print-cartridge door.

Output bins
CAUTION: To avoid damaging the product, do not attempt to clear a jam in the top output bin by pulling
the paper straight out.

1. At the back of the product, open the jam-release door.
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2. With both hands, grasp the jammed paper and slowly pull it out of the product.

3. Close the jam-release door.
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Solve print-quality problems
You can prevent most print-quality problems by following these guidelines.

● Configure the trays for the correct paper-type setting. See Configure trays on page 54.

● Use paper that meets HP specifications. See Paper and print media on page 43.

● Clean the product as necessary. See Clean the paper path on page 91.

Print-quality problems associated with paper
Some print-quality problems arise from using paper that does not meet HP specifications.

● The surface of the paper is too smooth.

● The moisture content of the paper is uneven, too high, or too low. Use paper from a different source
or from an unopened ream.

● Some areas of the paper reject toner. Use paper from a different source or from an unopened ream.

● The letterhead you are using is printed on rough paper. Use a smoother, xerographic paper. If this
solves your problem, ask the supplier of your letterhead to use paper that meets HP specifications.

● The paper is excessively rough. Use a smoother, xerographic paper.

● The paper is too heavy for the paper-type setting that you selected, so the toner is not fusing to
the paper.

For complete paper specifications for all HP LaserJet products, see the HP LaserJet Printer Family Print
Media Guide. This guide is available at www.hp.com/support/ljpaperguide.

Print-quality problems associated with the environment
If the product is operating in excessively humid or dry conditions, verify that the printing environment is
within specifications. See Operating environment on page 146.

Print-quality problems associated with jams
Make sure that all sheets are cleared from the paper path.

● If the product recently jammed, print two to three pages to clean the paper path.

● If the sheets do not pass through the fuser and cause image defects on subsequent documents,
print two to three pages to clean the paper path. If the problem persists, print and process a cleaning
page. See Clean the paper path on page 91.
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Image defect examples
This section provides information about identifying and correcting print defects.

NOTE: If these steps do not correct the problem, contact an HP-authorized dealer or service
representative.

Light print or faded

● The print cartridge is nearing end of life.

● Redistribute the toner to extend the life.

● The media might not meet Hewlett-Packard's media
specifications (for example, the media is too moist or too
rough).

● If the whole page is light, the print density adjustment is
too light or EconoMode might be turned on. Adjust the
print density, and disable EconoMode in the printer
Properties.

Toner specks

● The media might not meet Hewlett-Packard's media
specifications (for example, the media is too moist or too
rough).

● The printer might need to be cleaned.

● The print cartridge might be defective.

Dropouts

● A single sheet of media might be defective. Try reprinting
the job.

● The media moisture content is uneven or the media has
moist spots on its surface. Try printing with new media.

● The media lot is bad. The manufacturing processes can
cause some areas to reject toner. Try a different type or
brand of media.

● The print cartridge might be defective.
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Vertical lines

The photosensitive drum inside the print cartridge has probably
been scratched. Install a new HP print cartridge.

Gray background

● Change the media to a lighter basis weight.

● Check the printer's environment. Very dry (low humidity)
conditions can increase the amount of background
shading.

● The density setting might be too high. Adjust the density
setting.

● Install a new HP print cartridge.

Toner smear

● If toner smears appear on the leading edge of the media,
the media guides might be dirty. Wipe the media guides
with a dry, lint-free cloth.

● Check the media type and quality.

● The fuser temperature might be too low. In your printer
driver, make sure the appropriate media type is selected.

● Try installing a new HP print cartridge.

Loose toner

● The fuser temperature might be too low. In your printer
driver, make sure the appropriate media type is selected.

● Clean the inside of the printer.

● Check the media type and quality.

● In your printer driver, make sure the appropriate media
type is selected.

● Plug the printer directly into an AC outlet instead of into a
power strip.
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Vertical repetitive defects

● The print cartridge might be damaged. If a repetitive mark
occurs at the same spot on the page, install a new
HP print cartridge.

● The internal parts might have toner on them. If the defects
occur on the back of the page, the problem will probably
correct itself after a few more printed pages.

● In your printer driver, make sure the appropriate media
type is selected.

Misformed characters

● If characters are improperly formed, producing hollow
images, the media stock might be too slick. Try a different
media.

● If characters are improperly formed, producing a wavy
effect, the printer might need service. Print a configuration
page. If the characters are improperly formed, contact an
HP-authorized dealer or service representative.

Page skew

● Make sure that the media is loaded correctly and the
media guides are not too tight or too loose against the
media stack.

● The input bin might be too full.

● Check the media type and quality.
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Curl or wave

● Check the media type and quality. Both high temperature
and high humidity cause media to curl.

● The media might have been in the input tray too long.
Turn over the stack of media in the tray. Also, try rotating
the media 180° in the input tray.

● Open the straight-through output door and try printing
straight through.

● The fuser temperature might be too high. In your printer
driver, make sure the appropriate media type is selected.
If the problem persists, select a media type that uses a
lower fuser temperature, such as transparencies or light
media.

Wrinkles or creases

● Make sure that media is loaded properly.

● Check the media type and quality.

● Open the straight-through output door and try printing
straight through.

● Turn over the stack of media in the tray. Also, try rotating
the media 180° in the input tray.

● For envelopes, this can be caused by air pockets inside
the envelope. Remove the envelope, flatten the
envelope, and try printing again.

Toner scatter outline

● If large amounts of toner have scattered around the
characters, the media might be resisting the toner. (A
small amount of toner scatter is normal for laser printing.)
Try a different media type.

● Turn over the stack of media in the tray.

● Use media that is designed for laser printers.
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Solve performance problems
Problem Cause Solution

Pages print but are totally blank. The sealing tape might still be in the print
cartridges.

Verify that the sealing tape has been
completely removed from the print
cartridges.

The document might contain blank
pages.

Check the document that you are printing
to see if content appears on all of the
pages.

The product might be malfunctioning. To check the product, print a
Configuration page.

Pages print very slowly. Heavier paper types can slow the print
job.

Print on a different type of paper.

Complex pages can print slowly. Proper fusing may require a slower print
speed to ensure the best print quality.

Pages did not print. The product might not be pulling paper
correctly.

Make sure paper is loaded in the tray
correctly.

The paper is jamming in the product. Clear the jam. See Jams on page 106.

The USB cable might be defective or
incorrectly connected.

● Disconnect the USB cable at both
ends and reconnect it.

● Try printing a job that has printed in
the past.

● Try using a different USB cable.

Other devices are running on your
computer.

The product might not share a USB port.
If you have an external hard drive or
network switchbox that is connected to
the same port as the product, the other
device might be interfering. To connect
and use the product, you must
disconnect the other device or you must
use two USB ports on the computer.
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Solve connectivity problems
Solve direct-connect problems

If you have connected the product directly to a computer, check the cable.

● Verify that the cable is connected to the computer and to the product.

● Verify that the cable is not longer than 2 meters (6 feet). Replace the cable if necessary.

● Verify that the cable is working correctly by connecting it to another product. Replace the cable if
necessary.

Solve network problems
Check the following items to verify that the product is communicating with the network. Before beginning,
print a configuration page. See Print the information pages on page 70.

1. Are there any physical connection problems between the workstation or file server and the product?

Verify that the network cabling, connections, and router configurations are correct. Verify that the
network cable lengths meet network specifications.

2. Are your network cables connected properly?

Make sure that the product is attached to the network using the appropriate port and cable. Check
each cable connection to make sure it is secure and in the right place. If the problem continues,
try a different cable or ports on the hub or transceiver. The amber activity light and the green link
status light next to the port connection on the back of the product should be lit.

3. Are the link speed and duplex settings set correctly?

Hewlett-Packard recommends leaving this setting in automatic mode (the default setting). See Link
speed setting on page 41.

4. Can you "ping" the product?

Use the command prompt to ping the product from your computer. For example:

ping 192.168.45.39

Ensure that the ping displays round-trip times.

If you are able to ping the product, verify that the IP address configuration for the product is correct
on the computer. If it is correct, delete and then add the product again.

If the ping command failed, verify that the network hubs are on, and then verify that the network
settings, the product, and the computer are all configured for the same network.

5. Have any software applications been added to the network?

Make sure they are compatible and that they are installed correctly with the correct printer drivers.

6. Are other users able to print?

The problem may be workstation-specific. Check the workstation network drivers, printer drivers,
and redirection (capture in Novell NetWare).

7. If other users are able to print, are they using the same network operating system?
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Check your system for proper network operating system setup.

8. Is your protocol enabled?

Check the status of your protocol on the Configuration page. You can also use the embedded Web
server to check the status of other protocols. See Embedded Web server on page 77.

9. Does the product appear in HP Web Jetadmin or other management application?

● Verify network settings on the Network configuration page.

● Confirm the network settings for the product using the product control panel (for products with
control panels).
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Solve common Windows problems 
Error message:

"General Protection FaultException OE"

"Spool32"

"Illegal Operation"

Cause Solution

Close all software programs, restart Windows, and try again.

Select a different printer driver. You can usually do this from a
software program.

Delete all temp files from the Temp subdirectory. You can
determine the name of the directory by editing the
AUTOEXEC.BAT file and looking for the statement "Set Temp
=". The name after this statement is the temp directory. It is
usually C:\TEMP by default, but can be redefined.

See the Microsoft Windows documentation that came with your
computer for more information about Windows error
messages.
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Solve common Macintosh problems
NOTE:  Setup for USB and IP printing is performed through the Desktop Printer Utility. The product
will not appear in the Chooser.

The printer driver is not listed in Print Center.

Cause Solution

The product software might not have been installed or was
installed incorrectly.

Make sure that the PPD file is in the following hard drive folder:
Library/Printers/PPDs/Contents/Resources/
<lang>.lproj, where “<lang>” represents the two-letter
language code for the language that you are using. If
necessary, reinstall the software. See the getting started guide
for instructions.

The Postscript Printer Description (PPD) file is corrupt. Delete the PPD file from the following hard drive folder:
Library/Printers/PPDs/Contents/Resources/
<lang>.lproj, where “<lang>” represents the two-letter
language code for the language that you are using. Reinstall
the software. See the getting started guide for instructions.

The product name, IP address, or Rendezvous host name does not appear in the printer list box in the print center.

Cause Solution

The product might not be ready. Make sure that the cables are connected correctly, the product
is on, and the ready light is on. If you are connecting through
a USB or Ethernet hub, try connecting directly to the computer
or use a different port.

The wrong connection type might be selected. Make sure that USB, IP Printing, or Rendezvous is selected,
depending on the type of connection that exists between the
product and the computer.

The wrong product name, IP address, or Rendezvous host
name is being used.

Check the product name, IP address, or Rendezvous host
name by printing a configuration page. See Print the
information pages on page 70. Verify that the name, IP
address, or Rendezvous host name on the configuration page
matches the product name, IP address, or Rendezvous host
name in the Print Center.

The interface cable might be defective or of poor quality. Replace the interface cable. Make sure to use a high-quality
cable.

The printer driver does not automatically set up your selected product in Print Center.

Cause Solution

The product might not be ready. Make sure that the cables are connected correctly, the product
is on, and the ready light is on. If you are connecting through
a USB or Ethernet hub, try connecting directly to the computer
or use a different port.
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The printer driver does not automatically set up your selected product in Print Center.

Cause Solution

The product software might not have been installed or was
installed incorrectly.

Make sure that the PPD file is in the following hard drive folder:
Library/Printers/PPDs/Contents/Resources/
<lang>.lproj, where “<lang>” represents the two-letter
language code for the language that you are using. If
necessary, reinstall the software. See the getting started guide
for instructions.

The Postscript Printer Description (PPD) file is corrupt. Delete the PPD file from the following hard drive folder:
Library/Printers/PPDs/Contents/Resources/
<lang>.lproj, where “<lang>” represents the two-letter
language code for the language that you are using. Reinstall
the software. See the getting started guide for instructions.

The product might not be ready. Make sure that the cables are connected correctly, the product
is on, and the ready light is on. If you are connecting through
a USB or Ethernet hub, try connecting directly to the computer
or use a different port.

The interface cable might be defective or of poor quality. Replace the interface cable. Make sure to use a high-quality
cable.

A print job was not sent to the product that you wanted.

Cause Solution

The print queue might be stopped. Restart the print queue. Open print monitor and select Start
Jobs.

The wrong product name or IP address is being used. Another
product with the same or similar name, IP address, or
Rendezvous host name might have received your print job.

Check the product name, IP address, or Rendezvous host
name by printing a configuration page. See Print the
information pages on page 70. Verify that the name, IP
address, or Rendezvous host name on the configuration page
matches the product name, IP address, or Rendezvous host
name in the Print Center.

An encapsulated PostScript (EPS) file does not print with the correct fonts.

Cause Solution

This problem occurs with some programs. ● Try downloading the fonts that are contained in the EPS
file to the product before printing.

● Send the file in ASCII format instead of binary encoding.

You are unable to print from a third-party USB card.

Cause Solution

This error occurs when the software for USB devices is not
installed.

When adding a third-party USB card, you might need the Apple
USB Adapter Card Support software. The most current version
of this software is available from the Apple Web site.
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When connected with a USB cable, the product does not appear in the Macintosh Print Center after the driver is
selected.

Cause Solution

This problem is caused by either a software or a hardware
component.

Software problem-solving

● Check that your Macintosh supports USB.

● Verify that you are using a Macintosh operating system
that this product supports.

● Ensure that your Macintosh has the appropriate USB
software from Apple.

Hardware problem-solving

● Check that the product is turned on.

● Verify that the USB cable is connected correctly.

● Check that you are using the appropriate high-speed USB
cable.

● Ensure that you do not have too many USB devices
drawing power from the chain. Disconnect all of the
devices from the chain, and connect the cable directly to
the USB port on the host computer.

● Check to see if more than two nonpowered USB hubs are
connected in a row on the chain. Disconnect all of the
devices from the chain and connect the cable directly to
the USB port on the host computer.

NOTE: The iMac keyboard is a nonpowered USB hub.

Solve Linux problems
For information about Linux problem solving, go to the HP Linux support Web site: www.hp.com/go/
linuxprinting.
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A Supplies and accessories

● Order parts, accessories, and supplies

● Part numbers

ENWW 131



Order parts, accessories, and supplies
Several methods are available for ordering parts, supplies, and accessories.

Order directly from HP
You can obtain the following items directly from HP:

● Replacement parts: To order replacement parts in the U.S., go to www.hp.com/go/hpparts.
Outside the United States, order parts by contacting your local authorized HP service center.

● Supplies and accessories: To order supplies in the U.S., go to www.hp.com/go/ljsupplies. To
order supplies worldwide, go to www.hp.com/ghp/buyonline.html. To order accessories, go to
www.hp.com/support/ljp2050series.

Order through service or support providers
To order a part or accessory, contact an HP-authorized service or support provider.

Order directly through the HP ToolboxFX software
HP ToolboxFX software is a product management tool designed to make product configuration,
monitoring, supplies ordering, troubleshooting, and updating as simple and efficient as possible. For
more information about HP ToolboxFX software, see Use the HP ToolboxFX software on page 71.
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Part numbers
The following list of accessories was current at the time of printing. Ordering information and availability
of the accessories might change during the life of the product.

Paper-handling accessories

Item Description Part number

Optional 500-sheet tray and feeder unit Optional tray to increase paper capacity. CE464A

Print cartridges

Item Description Part number

HP LaserJet print cartridge Standard-capacity cartridge CE505A

High-capacity cartridge CE505X

Memory

Item Description Part number

44 x 32-pin DDR2 memory DIMM (dual
inline memory module)

Boosts the ability of the product to handle
large or complex print jobs.

32 MB CB420A

64 MB CB421A

128 MB CB422A

256 MB CB423A

Cables and interfaces

Item Description Part number

HP Jetdirect external print server
accessories

HP Jetdirect en1700 J7942G

HP Jetdirect en3700 J7942G

HP Jetdirect ew2400 USB wireless print
server

J7951G

HP Jetdirect 175x J6035G

HP USB network print adapter Q6275A (worldwide)

HP wireless printing upgrade kit Q6236A (North America)

Q6259A (Europe, Middle East, Africa,
and Asia-Pacific countries/regions)

USB cable 2-meter A to B cable C6518A
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B Service and support

● Hewlett-Packard limited warranty statement

● Print cartridge limited warranty statement

● End User License Agreement

● Customer self-repair warranty service

● Customer support

● HP maintenance agreements
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Hewlett-Packard limited warranty statement
HP PRODUCT DURATION OF LIMITED WARRANTY

HP LaserJet P2050 series One year from date of purchase

HP warrants to you, the end-user customer, that HP hardware and accessories will be free from defects
in materials and workmanship after the date of purchase, for the period specified above. If HP receives
notice of such defects during the warranty period, HP will, at its option, either repair or replace products
which prove to be defective. Replacement products may be either new or equivalent in performance to
new.

HP warrants to you that HP software will not fail to execute its programming instructions after the date
of purchase, for the period specified above, due to defects in material and workmanship when properly
installed and used. If HP receives notice of such defects during the warranty period, HP will replace
software which does not execute its programming instructions due to such defects.

HP does not warrant that the operation of HP products will be uninterrupted or error free. If HP is unable,
within a reasonable time, to repair or replace any product to a condition as warranted, you will be entitled
to a refund of the purchase price upon prompt return of the product.

HP products may contain remanufactured parts equivalent to new in performance or may have been
subject to incidental use.

Warranty does not apply to defects resulting from (a) improper or inadequate maintenance or calibration,
(b) software, interfacing, parts or supplies not supplied by HP, (c) unauthorized modification or misuse,
(d) operation outside of the published environmental specifications for the product, or (e) improper site
preparation or maintenance.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTIES ARE EXCLUSIVE AND
NO OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR
IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.
Some countries/regions, states or provinces do not allow limitations on the duration of an implied
warranty, so the above limitation or exclusion might not apply to you. This warranty gives you specific
legal rights and you might also have other rights that vary from country/region to country/region, state
to state, or province to province.

HP's limited warranty is valid in any country/region or locality where HP has a support presence for this
product and where HP has marketed this product. The level of warranty service you receive may vary
according to local standards. HP will not alter form, fit or function of the product to make it operate in a
country/region for which it was never intended to function for legal or regulatory reasons.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS WARRANTY STATEMENT
ARE YOUR SOLE AND EXCLUSIVE REMEDIES. EXCEPT AS INDICATED ABOVE, IN NO EVENT
WILL HP OR ITS SUPPLIERS BE LIABLE FOR LOSS OF DATA OR FOR DIRECT, SPECIAL,
INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR OTHER DAMAGE,
WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE. Some countries/regions, states or
provinces do not allow the exclusion or limitation of incidental or consequential damages, so the above
limitation or exclusion may not apply to you.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT
LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO
THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.

136 Appendix B   Service and support ENWW



Print cartridge limited warranty statement
This HP product is warranted to be free from defects in materials and workmanship.

This warranty does not apply to products that (a) have been refilled, refurbished, remanufactured or
tampered with in any way, (b) experience problems resulting from misuse, improper storage, or
operation outside of the published environmental specifications for the printer product or (c) exhibit wear
from ordinary use.

To obtain warranty service, please return the product to place of purchase (with a written description of
the problem and print samples) or contact HP customer support. At HP's option, HP will either replace
products that prove to be defective or refund your purchase price.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTY IS EXCLUSIVE AND NO
OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR
IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.

TO THE EXTENT ALLOWED BY LOCAL LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE
LIABLE FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR
DATA), OR OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT
LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO
THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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End User License Agreement
PLEASE READ CAREFULLY BEFORE USING THIS SOFTWARE PRODUCT: This End-User License
Agreement (“EULA”) is a contract between (a) you (either an individual or the entity you represent) and
(b) Hewlett-Packard Company (“HP”) that governs your use of the software product (“Software”). This
EULA does not apply if there is a separate license agreement between you and HP or its suppliers for
the Software, including a license agreement in online documentation. The term “Software” may include
(i) associated media, (ii) a user guide and other printed materials, and (iii) “online” or electronic
documentation (collectively “User Documentation”).

RIGHTS IN THE SOFTWARE ARE OFFERED ONLY ON THE CONDITION THAT YOU AGREE TO
ALL TERMS AND CONDITIONS OF THIS EULA. BY INSTALLING, COPYING, DOWNLOADING, OR
OTHERWISE USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THIS EULA. IF YOU DO
NOT ACCEPT THIS EULA, DO NOT INSTALL, DOWNLOAD, OR OTHERWISE USE THE
SOFTWARE. IF YOU PURCHASED THE SOFTWARE BUT DO NOT AGREE TO THIS EULA, PLEASE
RETURN THE SOFTWARE TO YOUR PLACE OF PURCHASE WITHIN FOURTEEN DAYS FOR A
REFUND OF THE PURCHASE PRICE; IF THE SOFTWARE IS INSTALLED ON OR MADE
AVAILABLE WITH ANOTHER HP PRODUCT, YOU MAY RETURN THE ENTIRE UNUSED
PRODUCT.

1. THIRD PARTY SOFTWARE. The Software may include, in addition to HP proprietary software
(“HP Software”), software under licenses from third parties (“Third Party Software” and “Third Party
License”). Any Third Party Software is licensed to you subject to the terms and conditions of the
corresponding Third Party License. Generally, the Third Party License is located in a file such as
license.txt; you should contact HP support if you cannot find any Third Party License. If the Third Party
Licenses include licenses that provide for the availability of source code (such as the GNU General
Public License) and the corresponding source code is not included with the Software, then check the
product support pages of HP’s website (hp.com) to learn how to obtain such source code.

2. LICENSE RIGHTS. You will have the following rights provided you comply with all terms and
conditions of this EULA:

a. Use. HP grants you a license to Use one copy of the HP Software. “Use” means installing, copying,
storing, loading, executing, displaying, or otherwise using the HP Software. You may not modify the
HP Software or disable any licensing or control feature of the HP Software. If this Software is provided
by HP for Use with an imaging or printing product (for example, if the Software is a printer driver,
firmware, or add-on), the HP Software may only be used with such product (“HP Product”). Additional
restrictions on Use may appear in the User Documentation. You may not separate component parts of
the HP Software for Use. You do not have the right to distribute the HP Software.

b. Copying. Your right to copy means you may make archival or back-up copies of the HP Software,
provided each copy contains all the original HP Software’s proprietary notices and is used only for back-
up purposes.

3. UPGRADES. To Use HP Software provided by HP as an upgrade, update, or supplement (collectively
“Upgrade”), you must first be licensed for the original HP Software identified by HP as eligible for the
Upgrade. To the extent the Upgrade supersedes the original HP Software, you may no longer use such
HP Software. This EULA applies to each Upgrade unless HP provides other terms with the Upgrade. In
case of a conflict between this EULA and such other terms, the other terms will prevail.

4. TRANSFER.

a. Third Party Transfer. The initial end user of the HP Software may make a one-time transfer of the
HP Software to another end user. Any transfer will include all component parts, media, User
Documentation, this EULA, and if applicable, the Certificate of Authenticity. The transfer may not be an
indirect transfer, such as a consignment. Prior to the transfer, the end user receiving the transferred
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Software will agree to this EULA. Upon transfer of the HP Software, your license is automatically
terminated.

b. Restrictions. You may not rent, lease or lend the HP Software or Use the HP Software for commercial
timesharing or bureau use. You may not sublicense, assign or otherwise transfer the HP Software except
as expressly provided in this EULA.

5. PROPRIETARY RIGHTS. All intellectual property rights in the Software and User Documentation are
owned by HP or its suppliers and are protected by law, including applicable copyright, trade secret,
patent, and trademark laws. You will not remove any product identification, copyright notice, or
proprietary restriction from the Software.

6. LIMITATION ON REVERSE ENGINEERING. You may not reverse engineer, decompile, or
disassemble the HP Software, except and only to the extent that the right to do so is allowed under
applicable law.

7. CONSENT TO USE OF DATA. HP and its affiliates may collect and use technical information you
provide in relation to (i) your Use of the Software or the HP Product, or (ii) the provision of support
services related to the Software or the HP Product. All such information will be subject to HP’s privacy
policy. HP will not use such information in a form that personally identifies you except to the extent
necessary to enhance your Use or provide support services.

8. LIMITATION OF LIABILITY. Notwithstanding any damages that you might incur, the entire liability of
HP and its suppliers under this EULA and your exclusive remedy under this EULA will be limited to the
greater of the amount actually paid by you for the Product or U.S. $5.00. TO THE MAXIMUM EXTENT
PERMITTED BY APPLICABLE LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE LIABLE FOR
ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES (INCLUDING
DAMAGES FOR LOST PROFITS, LOST DATA, BUSINESS INTERRUPTION, PERSONAL INJURY,
OR LOSS OF PRIVACY) RELATED IN ANY WAY TO THE USE OF OR INABILITY TO USE THE
SOFTWARE, EVEN IF HP OR ANY SUPPLIER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES AND EVEN IF THE ABOVE REMEDY FAILS OF ITS ESSENTIAL PURPOSE. Some states
or other jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so
the above limitation or exclusion may not apply to you.

9. U.S. GOVERNMENT CUSTOMERS. If you are a U.S. Government entity, then consistent with FAR
12.211 and FAR 12.212, Commercial Computer Software, Computer Software Documentation, and
Technical Data for Commercial Items are licensed under the applicable HP commercial license
agreement.

10. COMPLIANCE WITH EXPORT LAWS. You will comply with all laws, rules, and regulations (i)
applicable to the export or import of the Software, or (ii) restricting the Use of the Software, including
any restrictions on nuclear, chemical, or biological weapons proliferation.

11. RESERVATION OF RIGHTS. HP and its suppliers reserve all rights not expressly granted to you
in this EULA.

(c) 2007 Hewlett-Packard Development Company, L.P.

Rev. 11/06
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Customer self-repair warranty service
HP products are designed with many Customer Self Repair (CSR) parts to minimize repair time and
allow for greater flexibility in performing defective parts replacement. If during the diagnosis period, HP
identifies that the repair can be accomplished by the use of a CSR part, HP will ship that part directly to
you for replacement. There are two categories of CSR parts: 1) Parts for which customer self repair is
mandatory. If you request HP to replace these parts, you will be charged for the travel and labor costs
of this service. 2) Parts for which customer self repair is optional. These parts are also designed for
Customer Self Repair. If, however, you require that HP replace them for you, this may be done at no
additional charge under the type of warranty service designated for your product.

Based on availability and where geography permits, CSR parts will be shipped for next business day
delivery. Same-day or four-hour delivery may be offered at an additional charge where geography
permits. If assistance is required, you can call the HP Technical Support Center and a technician will
help you over the phone. HP specifies in the materials shipped with a replacement CSR part whether
a defective part must be returned to HP. In cases where it is required to return the defective part to HP,
you must ship the defective part back to HP within a defined period of time, normally five (5) business
days. The defective part must be returned with the associated documentation in the provided shipping
material. Failure to return the defective part may result in HP billing you for the replacement. With a
customer self repair, HP will pay all shipping and part return costs and determine the courier/carrier to
be used.
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Customer support
Get telephone support, free during your warranty period, for
your country/region

Have the product name, serial number, date of purchase, and
problem description ready.

Country/region phone numbers are on the flyer that was in the
box with your product or at www.hp.com/support/.

Get 24-hour Internet support www.hp.com/support/ljp2050series

Get support for products used with a Macintosh computer www.hp.com/go/macosx

Download software utilities, drivers, and electronic information www.hp.com/go/ljp2050series_software

Order additional HP service or maintenance agreements www.hp.com/go/carepack
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HP maintenance agreements
HP has several types of maintenance agreements that meet a wide range of support needs.
Maintenance agreements are not part of the standard warranty. Support services may vary by area.
Check with your local HP dealer to determine the services available to you.

On-site service agreements
To provide you with the level of support best suited to your needs, HP has on-site service agreements
with a selection of response times.

Next-day on-site service
This agreement provides support by the next working day following a service request. Extended
coverage hours and extended travel beyond HP’s designated service zones are available on most on-
site agreements (for additional charges).

Weekly (volume) on-site service
This agreement provides scheduled weekly on-site visits for organizations with many HP products. This
agreement is designated for sites using 25 or more workstation products, including devices, plotters,
computers, and disk drives.

Repack the product
If HP Customer Care determines that your product needs to be returned to HP for repair, follow these
steps to repack the product before shipping it.

CAUTION: Shipping damage as a result of inadequate packing is the customer’s responsibility.

1. Remove and retain any DIMMs cards that you have purchased and installed in the device. Do not
remove the DIMM that came with the device.

CAUTION: Static electricity can damage DIMMs. When handling DIMMs, either wear an antistatic
wrist strap, or frequently touch the surface of the DIMM antistatic package and then touch bare
metal on the device. To remove the DIMMs, see Install memory on page 85.

2. Remove and retain the print cartridge.

CAUTION: It is extremely important to remove the print cartridge before shipping the product. A
print cartridge that remains in the product during shipping can leak and cover the product engine
and other parts with toner.

To prevent damage to the print cartridge, avoid touching the roller on it, and store the print cartridge
in its original packing material or so that it is not exposed to light.

3. Remove and retain the power cable, interface cable, and optional accessories.

4. If possible, include print samples and 50 to 100 sheets of paper or other print media that did not
print correctly.

5. In the U.S., call HP Customer Care to request new packing material. In other areas, use the original
packing material, if possible. Hewlett-Packard recommends insuring the equipment for shipment.
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Extended warranty
HP Support provides coverage for the HP hardware product and all HP-supplied internal components.
The hardware maintenance covers a 1- to 3-year period from date of the HP product purchase. The
customer must purchase HP Support within the stated factory warranty. For more information, contact
the HP Customer Care Service and Support group.
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C Specifications

● Physical specifications

● Power consumption, electrical specifications, and acoustic emissions

● Operating environment
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Physical specifications
Table C-1  Product dimensions and weights

Product model Height Depth Width Weight

HP LaserJet P2050 Series 268 mm (10.6 in) 368 mm (14.5 in) 360 mm (14.2 in) 9.95 kg (21.9 lb)

HP LaserJet P2050 Series d model 268 mm (10.6 in) 368 mm (14.5 in) 360 mm (14.2 in) 10.6 kg (23.4 lb)

HP LaserJet P2050 Series dn model 268 mm (10.6 in) 368 mm (14.5 in) 360 mm (14.2 in) 10.6 kg (23.4 lb)

HP LaserJet P2050 Series x model 405 mm (15.9 in) 368 mm (14.5 in) 360 mm (14.2 in) 14.7 kg (32.4 lb)

Optional 500-sheet feeder 140 mm (5.5 in) 368 mm (14.5 in) 360 mm (14.2 in) 4.1 kg (9.0 lb)

Table C-2  Product dimensions with all doors and trays fully opened

Product model Height Depth Width

HP LaserJet P2050 Series 268 mm (10.6 in) 455 mm (17.9 in) 360 mm (14.2 in)

HP LaserJet P2050 Series d model 268 mm (10.6 in) 455 mm (17.9 in) 360 mm (14.2 in)

HP LaserJet P2050 Series dn model 268 mm (10.6 in) 455 mm (17.9 in) 360 mm (14.2 in)

HP LaserJet P2050 Series x model 405 mm (15.9 in) 455 mm (17.9 in) 360 mm (14.2 in)

Power consumption, electrical specifications, and
acoustic emissions

See www.hp.com/go/ljp2050/regulatory for current information.

CAUTION: Power requirements are based on the country/region where the product is sold. Do not
convert operating voltages. This will damage the product and void the product warranty.

Operating environment
Table C-3  Necessary conditions

Environmental condition Printing Storage/standby

Temperature (product and print
cartridge)

7.5° to 32.5°C (45.5° to 90.5°F) 0° to 35°C (32° to 95°F)

Relative humidity 10% to 80% 10% to 90%
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D Regulatory information

● FCC regulations

● Environmental product stewardship program

● Declaration of conformity

● Safety statements
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FCC regulations
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy. If this equipment is not installed and used in accordance with the instructions, it may
cause harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following measures:

● Reorient or relocate the receiving antenna.

● Increase separation between equipment and receiver.

● Connect equipment to an outlet on a circuit different from that to which the receiver is located.

● Consult your dealer or an experienced radio/TV technician.

NOTE: Any changes or modifications to the printer that are not expressly approved by HP could void
the user’s authority to operate this equipment.

Use of a shielded interface cable is required to comply with the Class B limits of Part 15 of FCC rules.
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Environmental product stewardship program
Protecting the environment

Hewlett-Packard Company is committed to providing quality products in an environmentally sound
manner. This product has been designed with several attributes to minimize impacts on our environment.

Ozone production
This product generates no appreciable ozone gas (O3).

Power consumption
Power usage drops significantly while in Ready mode, which saves natural resources and saves money
without affecting the high performance of this product. To determine the ENERGY STAR® qualification
status for this product, see the Product Data Sheet or Specifications Sheet. Qualified products are also
listed at:

www.hp.com/go/energystar

Toner consumption
EconoMode uses less toner, which might extend the life of the print cartridge.

Paper use
This product’s optional automatic duplex feature (two-sided printing) and N-up printing (multiple pages
printed on one page) capability can reduce paper usage and the resulting demands on natural
resources.

Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the ability to
identify plastics for recycling purposes at the end of the product’s life.

HP LaserJet print supplies
It’s easy to return and recycle your HP LaserJet print cartridges after use—free of charge—with
HP Planet Partners. Multilingual program information and instructions are included in every new
HP LaserJet print cartridge and supplies package. You help reduce the toll on the environment further
when you return multiple cartridges together rather than separately.

HP is committed to providing inventive, high-quality products and services that are environmentally
sound, from product design and manufacturing to distribution, customer use and recycling. When you
participate in the HP Planet Partners program, we ensure your HP LaserJet print cartridges are recycled
properly, processing them to recover plastics and metals for new products and diverting millions of tons
of waste from landfills. Since this cartridge is being recycled and used in new materials, it will not be
returned to you. Thank you for being environmentally responsible!

NOTE: Use the return label to return original HP LaserJet print cartridges only. Please do not use this
label for HP inkjet cartridges, non-HP cartridges, refilled or remanufactured cartridges or warranty
returns. For information about recycling your HP inkjet cartridges please go to http://www.hp.com/
recycle.
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Return and recycling instructions

United States and Puerto Rico
The enclosed label in the HP LaserJet toner cartridge box is for the return and recycling of one or more
HP LaserJet print cartridges after use. Please follow the applicable instructions below.

Multiple returns (more than one cartridge)

1. Package each HP LaserJet print cartridge in its original box and bag.

2. Tape the boxes together using strapping or packaging tape. The package can weigh up to 31 kg
(70 lb).

3. Use a single pre-paid shipping label.

OR

1. Use your own suitable box, or request a free bulk collection box from www.hp.com/recycle or
1-800-340-2445 (holds up to 31 kg (70 lb) of HP LaserJet print cartridges).

2. Use a single pre-paid shipping label.

Single returns

1. Package the HP LaserJet print cartridge in its original bag and box.

2. Place the shipping label on the front of the box.

Shipping

For all HP LaserJet print cartridge recycling returns, give the package to UPS during your next delivery
or pickup, or take it to an authorized UPS drop-off center. For the location of your local UPS drop-off
center, call 1-800-PICKUPS or visit www.ups.com. If you are returning via USPS label, give the package
to a U.S. Postal Service carrier or drop off at a U.S. Postal Service Office. For more information, or to
order additional labels or boxes for bulk returns, visit www.hp.com/recycle or call 1-800-340-2445.
Requested UPS pickup will be charged normal pickup rates. Information subject to change without
notice.

Residents of Alaska and Hawaii

Do not use the UPS label. Call 1-800-340-2445 for information and instructions. The U.S. Postal Service
provides no-cost cartridge return transportation services under an arrangement with HP for Alaska and
Hawaii.

Non-U.S. returns
To participate in HP Planet Partners return and recycling program, just follow the simple directions in
the recycling guide (found inside the packaging of your new product supply item) or visit www.hp.com/
recycle. Select your country/region for information on how to return your HP LaserJet printing supplies.

Paper
This product is capable of using recycled papers when the paper meets the guidelines outlined in the
HP LaserJet Printer Family Print Media Guide. This product is suitable for the use of recycled paper
according to EN12281:2002.
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Material restrictions
This HP product does not contain added mercury.

This HP product does not contain a battery.

Disposal of waste equipment by users in private households in the
European Union

This symbol on the product or on its packaging indicates that this product must not be disposed of with
your other household waste. Instead, it is your responsibility to dispose of your waste equipment by
handing it over to a designated collection point for the recycling of waste electrical and electronic
equipment. The separate collection and recycling of your waste equipment at the time of disposal will
help to conserve natural resources and ensure that it is recycled in a manner that protects human health
and the environment. For more information about where you can drop off your waste equipment for
recycling, please contact your local city office, your household waste disposal service or the shop where
you purchased the product.

Material Safety Data Sheet (MSDS)
Material Safety Data Sheets (MSDS) for supplies containing chemical substances (for example, toner)
can be obtained by accessing the HP Web site at www.hp.com/go/msds or www.hp.com/hpinfo/
community/environment/productinfo/safety.

For more information
To obtain information about these environmental topics:

● Product environmental profile sheet for this and many related HP products

● HP’s commitment to the environment

● HP’s environmental management system

● HP’s end-of-life product return and recycling program

● Material Safety Data Sheets

Visit www.hp.com/go/environment or www.hp.com/hpinfo/globalcitizenship/environment.
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Declaration of conformity
Declaration of conformity
Declaration of Conformity
according to ISO/IEC 17050-1 and EN 17050-1, DoC#: BOISB-0801-00-rel.1.0
Manufacturer's Name: Hewlett-Packard Company
Manufacturer's Address: 11311 Chinden Boulevard,

Boise, Idaho 83714-1021, USA
declares, that the product

Product Name: HP LaserJet P2050 Series
  
Regulatory Model Number2): BOISB-0801-00

Including CE464A — Optional 500-sheet input tray
Product Options: ALL

Print Cartridges: CE505A, CE505X
conforms to the following Product Specifications:

Safety: IEC 60950-1:2001 / EN60950-1: 2001 +A11
IEC 60825-1:1993 +A1 +A2 / EN 60825-1:1994 +A1 +A2 (Class 1 Laser/LED Product)
GB4943-2001

EMC: CISPR22:2005 / EN 55022:2006 - Class B1)

EN 61000-3-2:2000 +A2
EN 61000-3-3:1995 +A1
EN 55024:1998 +A1 +A2
FCC Title 47 CFR, Part 15 Class B / ICES-003, Issue 4
GB9254-1998, GB17625.1-2003

Supplementary Information:

The product herewith complies with the requirements of the EMC Directive 2004/108/EC and the Low Voltage Directive 2006/95/EC, and
carries the CE-Marking  accordingly.

This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

1) The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.

2) For regulatory purposes, this product is assigned a Regulatory model number. This number should not be confused with the marketing
name or the product number(s).

Boise, Idaho , USA

October 22, 2007

For regulatory topics only:

European Contact: Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, Department HQ-TRE / Standards
Europe,, Herrenberger Strasse 140, , D-71034, Böblingen, (FAX: +49-7031-14-3143), http://www.hp.com/go/certificates

USA Contact: Product Regulations Manager, Hewlett-Packard Company,, PO Box 15, Mail Stop 160, Boise, ID 83707-0015, , (Phone:
208-396-6000)
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Safety statements
Laser safety

The Center for Devices and Radiological Health (CDRH) of the U.S. Food and Drug Administration has
implemented regulations for laser products manufactured since August 1, 1976. Compliance is
mandatory for products marketed in the United States. The device is certified as a “Class 1” laser product
under the U.S. Department of Health and Human Services (DHHS) Radiation Performance Standard
according to the Radiation Control for Health and Safety Act of 1968. Since radiation emitted inside the
device is completely confined within protective housings and external covers, the laser beam cannot
escape during any phase of normal user operation.

WARNING! Using controls, making adjustments, or performing procedures other than those specified
in this user guide may result in exposure to hazardous radiation.

Canadian DOC regulations
Complies with Canadian EMC Class B requirements.

« Conforme à la classe B des normes canadiennes de compatibilité électromagnétiques. « CEM ». »

VCCI statement (Japan)

Power cord statement (Japan)

EMC statement (Korea)
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Laser statement for Finland
Luokan 1 laserlaite

Klass 1 Laser Apparat

HP LaserJet P2055, P2055d, P2055dn, P2055x , laserkirjoitin on käyttäjän kannalta turvallinen luokan
1 laserlaite. Normaalissa käytössä kirjoittimen suojakotelointi estää lasersäteen pääsyn laitteen
ulkopuolelle. Laitteen turvallisuusluokka on määritetty standardin EN 60825-1 (1994) mukaisesti.

VAROITUS !

Laitteen käyttäminen muulla kuin käyttöohjeessa mainitulla tavalla saattaa altistaa käyttäjän
turvallisuusluokan 1 ylittävälle näkymättömälle lasersäteilylle.

VARNING !

Om apparaten används på annat sätt än i bruksanvisning specificerats, kan användaren utsättas för
osynlig laserstrålning, som överskrider gränsen för laserklass 1.

HUOLTO

HP LaserJet P2055, P2055d, P2055dn, P2055x - kirjoittimen sisällä ei ole käyttäjän huollettavissa olevia
kohteita. Laitteen saa avata ja huoltaa ainoastaan sen huoltamiseen koulutettu henkilö. Tällaiseksi
huoltotoimenpiteeksi ei katsota väriainekasetin vaihtamista, paperiradan puhdistusta tai muita käyttäjän
käsikirjassa lueteltuja, käyttäjän tehtäväksi tarkoitettuja ylläpitotoimia, jotka voidaan suorittaa ilman
erikoistyökaluja.

VARO !

Mikäli kirjoittimen suojakotelo avataan, olet alttiina näkymättömällelasersäteilylle laitteen ollessa
toiminnassa. Älä katso säteeseen.

VARNING !

Om laserprinterns skyddshölje öppnas då apparaten är i funktion, utsättas användaren för osynlig
laserstrålning. Betrakta ej strålen. Tiedot laitteessa käytettävän laserdiodin säteilyominaisuuksista:
Aallonpituus 775-795 nm Teho 5 m W Luokan 3B laser.
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Substances Table (China)
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Index

A
A6-size paper loading 52
accessibility features 4
accessories

available 3
ordering 132
part numbers 133

acoustic specifications 146
advanced printing options

Windows 67
alerts

setting up 72
viewing with HP

ToolboxFX 73
Alerts tab, HP ToolboxFX 73
alternative letterhead mode 67
anticounterfeit supplies 80
archive setting 15
automatic crossover, setting 16

B
batteries included 151
bins, output

capacity 48
locating 5
selecting 55

blank pages
troubleshooting 123

buttons, control panel 10

C
cables

USB, connecting 36
USB, troubleshooting 123

Canadian DOC regulations 153
canceling

printing 62
canceling a print request 62
card stock

output bin, selecting 56

cartridges
authentication 80
clean the area 90
features 3
genuine HP 80
non-HP 80
order message 105
part numbers 133
recycling 149
replace message 105
replacement intervals 80
replacing 80
status messages 10
status, viewing with HP

ToolboxFX 72
storage 80
supplies status page 12
warranty 137

cartridges, print
Macintosh status 33

cleaning
pickup roller (Tray 1) 92
pickup roller (Tray 2) 95
print-cartridge area 90
printer 90

clearing jams
duplex paper path 109
locations 107
paper path 107
print-cartridge area 107
straight-through path 116
top output bin 116
Tray 1 112
Tray 2 113
Tray 3 115
See also jams

colored text
print as black 67

configuration page 12

control panel
buttons 10
cleaning page, printing 76
display 10
language 13
lights 10
locating 5
menu map, printing 12
menus 11
Network config. menu 16
Reports menu 12
Service menu 15
settings 22,  28
System Setup menu 13

copies, number of
Windows 67

counterfeit supplies 80
Courier font settings 14
cover pages 30,  64
curl, paper

settings 15
custom paper sizes 46
custom-size paper settings

Macintosh 30
customer support

Linux 129
online 102
repacking product 142

D
declaration of conformity 152
default settings, restoring 15
demo page 12
device discovery over network 37
device error message 104
Device Settings tab, HP

ToolboxFX 74
device status

Macintosh Services tab 33
dimensions, product 146
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DIMMs
accessing 5
part numbers 133
verifying installation 88

disposal, end-of-life 151
double-sided printing

paper loading orientation 50
drivers

included 3
Macintosh settings 30
Macintosh, problem-

solving 127
paper types 47
presets (Macintosh) 30
settings 22,  23,  28,  29
shortcuts (Windows) 63
supported 20
universal 21
usage page 12
Windows, opening 63

duplex paper path
paper jams 109

duplex printing
paper loading orientation 50
Windows 65

E
E-mail alerts tab, HP

ToolboxFX 73
e-mail alerts, setting up 72
EconoMode setting 58
electrical specifications 146
embedded Web server 26,  29
Embedded Web Server (EWS)

Networking tab 78
order supplies 78
product support 78
security 78
Settings tab 78
Status tab 77
using 26

end-of-life disposal 151
envelopes

loading orientation 50
output bin, selecting 56

environment for the product
problem-solving 118
specifications 146

environmental stewardship
program 149

EPS files, problem-solving 128
error messages

lights, control panel 10
Ethernet cards, part

numbers 133
European Union, waste

disposal 151
Event log 72
EWS. See embedded Web server
extended warranty 143

F
factory defaults, restoring 15
fan error message 103
FastRes 3
features 2,  3
Finnish laser safety

statement 154
first page

use different paper 30
fonts

Courier settings 14
EPS files, problem-

solving 128
included 3
lists, printing 12
permanent resources 88

formatter
security 79

fraud hotline 80
fuser

errors 103

G
General Protection FaultException

OE 126

H
heavy paper

output bin, selecting 56
Help tab, HP ToolboxFX 73
HP Customer Care 102
HP fraud hotline 80
HP Jetdirect print server

part numbers 133
HP postscript emulation Universal

Print Driver 20
HP SupportPack 143
HP ToolboxFX

about 25
Alerts tab 73

Device Settings tab 74
E-mail alerts tab 73
Help tab 73
Network Settings tab 76
Status tab 72
System Setup tab 76

HP Universal Print Driver 21
HP Web Jetadmin 26,  78
HP-UX software 26
humidity

problem-solving 118
specifications 146

I
Illegal Operation errors 126
image quality

archive setting 15
HP ToolboxFX settings 75

improve print quality 119
information pages

printing 26
input tray

loading media 52
install supplies message 104
IP address

automatic configuration 40
Macintosh, problem-

solving 127
manual configuration 40
protocols supported 38

J
jams

common causes of 106
locations 107
print quality after 118
tracking number of 12
See also clearing jams

jams <location>
error messages 102

Japanese VCCI statement 153
Jetadmin, HP Web 26,  78
Jetdirect print server

part numbers 133

K
Korean EMC statement 153

L
labels

output bin, selecting 56
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landscape orientation
setting, Windows 65

language, control panel 13
laser safety statements 153,  154
letterhead paper, loading 67
license, software 138
lights, control panel 10
link speed settings 41
Linux drivers 129
Linux software 26
loading media

A6-size paper 52
error messages 104
optional Tray 3 52
Tray 1 51
Tray 2 52

lock the product 79

M
Macintosh

driver settings 29,  30
drivers, problem-solving 127
problems, problem-

solving 127
removing software 28
resize documents 30
support 141
supported operating

systems 28
USB card, problem-

solving 128
Macintosh driver settings

custom-size paper 30
Services tab 33
watermarks 31

maintenance agreements 142
managing network 39
manual-feed printing 53
material restrictions 151
Material Safety Data Sheet

(MSDS) 151
media

curl settings 15
custom-size, Macintosh

settings 30
default settings 13,  75
first page 30
HP ToolboxFX settings 74
pages per sheet 31

printing manually 53
supported sizes 45

media jams. See jams
memory

DIMMs, security 79
error messages 105
part numbers 133
permanent resources 88
verifying installation 88

menus, control panel
accessing 11
map, printing 12
Network config. 16
Reports 12
Service 15
System Setup 13

mercury-free product 151
messages

lights, control panel 10
misprint error message 105
models, feature comparison 2
multiple pages per sheet

Windows 65

N
n-up printing

Windows 65
network

IP address configuration 40
link speed settings 41
password, changing 39
password, setting 39
port, setting up 38
product discovery 37
protocols supported 37
settings, changing 39
settings, viewing 39

Network config. menu 16
Network Settings tab, HP

ToolboxFX 76
Networking tab (embedded Web

server) 78
networks

configuration page 12
configuring 37
HP Web Jetadmin 78
settings 16
settings report 12

next-day on-site service 142
non-HP supplies 80

O
on-site service agreements 142
on/off switch, locating 5
online support 102
operating environment

specifications 146
operating systems supported 20,

28
order supplies message 105
ordering

part numbers for 133
supplies and accessories 132

orientation
paper, while loading 50
setting, Windows 65

output quality
archive setting 15
HP ToolboxFX settings 75

P
packaging product 142
page count 12
page order, changing 67
pages

blank 123
not printing 123
per sheet, Windows 65
printing slowly 123

pages per sheet 31
paper

A6-size, tray adjustment 52
covers, using different

paper 64
curl settings 15
custom size, selecting 64
custom sizes 46
custom-size, Macintosh

settings 30
default settings 13,  75
first and last pages, using

different paper 64
first page 30
HP ToolboxFX settings 76
loading orientation 50
pages per sheet 31
problem-solving 118
size, selecting 64
supported sizes 45
supported types 47
type, selecting 64
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paper jams. See jams
paper path

paper jams 107
part numbers

memory 133
print cartridges 133
trays 133

pausing a print request 62
PCL drivers

universal 21
PCL font list 12
PCL settings, HP ToolboxFX 75
permanent resources 88
physical specifications 146
pickup roller

Tray 1 92
Tray 2 95

portrait orientation
setting, Windows 65

ports
problem-solving

Macintosh 128
supported 3
USB 36

postcards
output bin, selecting 56

PostScript Printer Description
(PPD) files

problem-solving 127
PostScript settings, HP

ToolboxFX 75
power

consumption 146
switch, locating 5
troubleshooting 100

PPDs
problem-solving 127

presets (Macintosh) 30
print cartridges

authentication 80
clean the area 90
features 3
genuine HP 80
Macintosh status 33
non-HP 80
order message 105
paper jams in area 107
part numbers 133
recycling 149
redistributing toner 82

replace message 105
replacement intervals 80
replacing 80
status messages 10
status, viewing with HP

ToolboxFX 72
storage 80
supplies status page 12
warranty 137

print failure error message 102
print on both sides

Windows 65
print quality

archive setting 15
creases 122
curl 122
dropouts 119
environment 118
gray background 120
HP ToolboxFX settings 75
improve 119
jams, after 118
light or faded print 119
loose toner 120
misformed characters 121
page skew 121
paper 118
problem-solving 118
toner scatter outline 122
toner smear 120
toner specks 119
vertical lines 120
vertical repetitive defects 121
wave 122
wrinkles 122

print tasks 61
printing

connect to a network 38
manual feed 53
troubleshooting 123

priority, settings 22,  28
problem-solving

environment 118
EPS files 128
Linux 129
Macintosh problems 127
output quality 118
paper 118

processor speed 3

product
comparison 2
registration 76

ProRes 3
protocols, networks 37
PS font list 12

Q
quality

archive setting 15
HP ToolboxFX settings 75

Quick Sets 63
quiet mode

enabling 13,  59

R
rear output

bin, locating 5
printing to 56

recycling
HP printing supplies returns and

environmental program 150
redistributing toner 82
registration, product 76
removing Macintosh software 28
repacking product 142
replace supplies message 105
replacing printing cartridges 80
Reports menu 12
resize documents

Macintosh 30
Windows 64

resolution
features 3
problem-solving quality 118

resource saving 88
restoring default settings 15
right-side panel, locating 5
rough paper

output bin, selecting 56

S
safety statements 153,  154
saving resources, memory 88
scale documents

Macintosh 30
Windows 64

security features 78,  79
service

repacking product 142
service agreements 142
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service error message 104
Service menu 15
service page 12
Services tab

Macintosh 33
settings

driver presets (Macintosh) 30
drivers 23,  29
HP ToolboxFX 74
network printing 38
network report 12
priority 22,  28
restoring defaults 15
System Setup menu 13

Settings tab (embedded Web
server) 78

shipping lock error message 105
shipping product 142
shortcuts 63
SIMMs, incompatibility 85
sizes, media

default, setting 13
small paper, printing on 56
software

embedded Web server 26,
29

HP Web Jetadmin 26
settings 22,  28
software license

agreement 138
supported operating

systems 20,  28
uninstalling for Windows 24
uninstalling Macintosh 28

Solaris software 26
solving

creases 122
curl 122
direct-connect problems 124
dropouts 119
gray background 120
light or faded print 119
loose toner 120
misformed characters 121
network problems 100
page skew 121
toner scatter outline 122
toner smear 120
toner specks 119
vertical lines 120

vertical repetitive defects 121
wave 122
wrinkles 122

special media
guidelines 49

special paper
guidelines 49

specifications
electrical and acoustic 146
features 3
operating environment 146
physical 146

Spool32 errors 126
status

alerts, HP ToolboxFX 72
Macintosh services tab 33
supplies, control panel

messages 10
supplies, printing report 12
viewing with HP

ToolboxFX 72
Status tab (embedded Web

server) 77
Status tab, HP ToolboxFX 72
stopping a print request 62
storing

print cartridges 80
straight-through paper path

paper jams 116
supplies

authentication 80
counterfeit 80
non-HP 80
order message 105
ordering 76,  132
part numbers 133
recycling 149
replace message 105
replacement intervals 80
replacing print cartridges 80
shipping lock error

message 105
status page 12
status, control panel

messages 10
status, viewing with HP

ToolboxFX 72
supply-status, Services tab

Macintosh 33
Windows 66

support
Linux 129
online 66,  76,  102
repacking product 142

supported media 45
SupportPack, HP 143
System Setup menu 13
System Setup tab, HP

ToolboxFX 76

T
TCP/IP

protocols supported 37
settings 16

technical support
Linux 129
online 102
repacking product 142

temperature specifications 146
toner

loose toner 120
low 119
redistributing 82
scatter outline 122
smear 120
specks 119

toner cartridges. See print
cartridges

top output bin
capacity 48
locating 5
paper jams 116
printing to 55

transparencies
output bin 55

Tray 1
capacity 48
loading 51
paper jams 112
settings 13

Tray 2
capacity 48
loading 52
paper jams 113
settings 13

Tray 3
capacity 48
loading 52
paper jams 115
physical specifications 146
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trays
capacity 48
configure 54
double-sided printing 32
load error messages 104
locating 5
paper orientation 50
part numbers 133
settings 13,  75

troubleshooting
blank pages 123
checklist 100
direct-connect problems 124
network problems 100
pages not printing 123
pages printing slowly 123
paper jams 100,  107,  112,

113,  116
paper pickup (Tray 1) 92
paper pickup (Tray 2) 95
USB cables 123

Troubleshooting tab
HP ToolboxFX settings 76

two-sided printing
Windows 65

types, media
HP ToolboxFX settings 76

U
uninstalling Macintosh

software 28
uninstalling Windows software 24
universal print driver 21
UNIX software 26
usage page 12
USB cable, part number 133
USB port

connecting 36
problem-solving

Macintosh 128
speed settings 15
supported 3
troubleshooting 123

W
warranty

customer self repair 140
extended 143
license 138

print cartridges 137
product 136

watermarks
Windows 64

Web server, embedded 26
Web sites

customer support 102
fraud reports 80
HP Web Jetadmin,

downloading 78
Linux support 129
Macintosh customer

support 141
Material Safety Data Sheet

(MSDS) 151
ordering supplies 132
universal print driver 21

weekly on-site service 142
weight, product 146
Windows

driver settings 23
drivers supported 20
software for 25
supported operating

systems 20
universal print driver 21
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